
CentreVu®  
Visual Vectors User Guide
Release 8

585-210-932
Comcode 108502220
Issue 1 
December 1999



Copyright  1999, Lucent Technologies
All Rights Reserved
Printed in U.S.A.

Notice
Every effort was made to ensure that the information in this book was 
complete and accurate at the time of printing. However, information is 
subject to change.

Your Responsibility for Your System’s Security
Toll fraud is the unauthorized use of your telecommunications system by 
an unauthorized party, for example, persons other than your company’s 
employees, agents, subcontractors, or persons working on your company’s 
behalf. Note that there may be a risk of toll fraud associated with your 
telecommunications system and, if toll fraud occurs, it can result in sub-
stantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your sys-
tem, such as programming and configuring your equipment to prevent 
unauthorized use. The system manager is also responsible for reading all 
installation, instruction, and system administration documents provided 
with this product in order to fully understand the features that can intro-
duce risk of toll fraud and the steps that can be taken to reduce that risk. 
Lucent Technologies does not warrant that this product is immune from or 
will prevent unauthorized use of common-carrier telecommunication ser-
vices or facilities accessed through or connected to it. Lucent Technolo-
gies will not be responsible for any charges that result from such 
unauthorized use.

Lucent Technologies Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need 
technical support or assistance, call Technical Service Center Toll Fraud 
Intervention Hotline at 1-800-643-2353.

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to 
comply with the limits for a Class A digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commer-
cial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communica-
tions. Operation of this equipment in a residential area is likely to cause 
harmful interference, in which case the user will be required to correct the 
interference at his own expense.

Part 15: Class B Statement. This equipment has been tested and found to 
comply with the limits for a Class B digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio-frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures: 

• Reorient the receiving television or radio antenna where this 
may be done safely.

• To the extent possible, relocate the receiver with respect to the 
telephone equipment.

• Where the telephone equipment requires ac power, plug the 
telephone into a different ac outlet so that the telephone equip-
ment and receiver are on different branch circuits.

Part 15: Personal Computer Statement. This equipment has been certi-
fied to comply with the limits for a Class B computing device, pursuant to 
Subpart J of Part 15 of FCC Rules. Only peripherals (computing input/
output devices, terminals, printers, etc.) certified to comply with the Class 
B limits may be attached to this computer. Operation with noncertified 
peripherals is likely to result in interference to radio and television recep-
tion.

Part 68: Answer-Supervision Signaling. Allowing this equipment to be 
operated in a manner that does not provide proper answer-supervision sig-
naling is in violation of Part 68 rules. This equipment returns answer-
supervision signals to the public switched network when:

• Answered by the called station
• Answered by the attendant
• Routed to a recorded announcement that can be administered 

by the CPE user
This equipment returns answer-supervision signals on all DID calls for-
warded back to the public switched telephone network. Permissible 
exceptions are: 

• A call is unanswered
• A busy tone is received
• A reorder tone is received

Canadian Department of Communications (DOC)
Interference Information
This digital apparatus does not exceed the Class A limits for radio noise 
emissions set out in the radio interference regulations of the Canadian 
Department of Communications.

Le Présent Appareil Nomérique n’émet pas de bruits radioélectriques 
dépassant les limites applicables aux appareils numériques de la class A 
préscrites dans le reglement sur le brouillage radioélectrique édicté par le 
ministére des Communications du Canada.
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• CONVERSANT is a registered trademark of Lucent Technolo-

gies.
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NT, and Access are registered trademarks of Microsoft Corpo-
ration.
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• Solaris is a trademark of Sun Microsystems, Inc.
• SPARC trademarks, including the SCD compliant logo, are 

trademarks or registered trademarks of SPARC International, 
Inc. SPARCstation, SPARCserver, SPARCengine, SPARC-
works, and SPARCompiler are licensed exclusively to Sun 
Microsystems, Inc. Products bearing SPARC trademarks are 
based upon an architecture developed by Sun Microsystems, 
Inc.

• Sun and Sun Microsystems are trademarks or registered trade-
marks of Sun Microsystems, Inc.

• Ultra Enterprise 3000 and Ultra 5 are trademarks of Sun 
Microsystems, Inc.

• UNIX is a registered trademark in the United States and other 
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About this information product

Purpose The CentreVu Visual Vectors User Guide 585-210-932 is written primarily 
for the CentreVu Call Management System (CMS) administrator who has 
access to all areas on one or more CentreVu CMS server(s), and 
secondarily for auxiliary administrators and split/skill supervisors who have 
limited access (for example, to Vectors and Vector Directory Numbers).

This book specifically addresses the DEFINITY Enterprise 
Communications Server (ECS) functionality of CentreVu CMS. If you are 
implementing CentreVu CMS R3V8 server for the first time, you will have 
DEFINITY ECS R8. This call center configuration supports all of the 
functions accessible using CentreVu Visual Vectors software.

Where to begin

Read “Setting Up Your Call Center World” and “Using Framework and 
Navigator” to learn how to use the CentreVu Framework interface.

Reason for reissue This document is being reissued to support Visual Vectors Release 8.0.

Safety labels Actions or inactions that may cause difficulties are labeled as follows:



  
About this information product CentreVu Visual Vectors User Guide Release 8

x

Caution

CAUTION
Indicates that failure to take or avoid a specified action could
result in loss of data.

Warning

WARNING
Indicates that failure to take or avoid a specified action could
result in physical harm to the operator or the equipment. 

How to use this
information product

The following table describes the contents of each chapter and appendix 
in this document.

No. Title Contents

1 Introduction Generally describes CentreVu 
Framework and Visual Vectors 
and includes things you should 
know before using the product.

2 Setting Up Your Call 
Center World

Describes how to use the 
Navigator user interface to set up 
the objects in your Call Center 
World.

3 Using Framework and 
the Navigator

Describes the CentreVu 
Framework user interface, and 
tells you how to view objects and 
perform actions with the Navigator 
tool.

4 Using the Vector Editor Tells you how to use the Vector 
Editor to create new and edit 
existing vectors, as well as to 
attach comments, display and 
print vectors. 

5 Using the VDN 
Administration Wizard

Tells you how to use this wizard-
based interface to assign VDNs to 
vectors and set Skill Preferences.
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Conventions used The following conventions are used throughout this document.

Product release

DEFINITY Enterprise Communications Server (ECS) is referred to as 
“ECS.” Unless otherwise noted, the term ECS refers to Release 6 or later. 
The functionality of earlier switch releases is noted if it differs from that of 
Releases 5, 6, and 8. 

Document number

Lucent publication titles are followed by their document number. For 
example, See CentreVu Visual Vectors Installation & Getting Started, 585-
210-933 for more information.

Typography

Courier font

 designates input and output.

• Input is something you type into the user interface. For example, 
Type x  next to Printer, Terminal, or File. 

• Output is a character, word or phrase that the system generates. For 
example, Please wait for initialization .....

Italic font highlights references to file names and directories. For example, 
/cms. 

Related documentation There are many documents that can help you use CentreVu CMS to its 
maximum capability. The title and document number of the most important 
ones are listed here.

• CentreVu Visual Vectors Installation and Getting Started, 585-210-933
• CentreVu CMS R3V8 Administration, 585-210-910
• Lucent Call Center Change Description, 585-215-853
• CentreVu CMS R3V8 Upgrades and Migration, 585-210–913
• CentreVu CMS R3V8 Software Installation and Maintenance, 585-

215–866
• Lucent Call Center Documentation CD-ROM, 585-210-926.

How to order By telephone:

Lucent Technologies Publications Center
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1 Introduction

............................................................................................................................................................................................................................................................
Overview

Purpose CentreVu Visual Vectors User Guide gives you the information you need to 
use the client software package.

 This introduction is divided into several main sections:

• “General Information” presents a brief overview of what the software 
does, who uses it, and how it works, followed by an overview of 
supporting hardware and software. 

• “Things to Know Before Using Framework and Visual Vectors” 
describes the interactions with other call center client software. 

• “Terminology” provides a list of key terms. A more extensive list of 
definitions appears in the glossary.

• “Things to Know About Call Center Data” describes common call 
center items, such as types of entities, data containers, and items.

• “Prerequisite System Administration” describes any system-level 
administration needed to run the client software, including 
permissions. 
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General Information

............................................................................................................................................................................................................................................................
Overview

Purpose CentreVu CMS/Visual Vectors software is a product used by businesses 
and organizations that have a Lucent Technologies telecommunications 
Enterprise Communications Server (ECS) or switch and receive a large 
volume of telephone calls that are processed through the Automatic Call 
Distribution (ACD) and Call Vectoring features of the switch. CentreVu 
CMS collects call-traffic data, formats management reports, and provides 
an administrative interface to the ACD feature on the switch.

The CentreVu CMS administrator can access the CentreVu CMS 
database, generate CMS reports, administer ACD parameters, and also 
monitor call activities to determine the most efficient service possible for 
the calling customers. The CentreVu CMS server supports CentreVu 
Supervisor client PCs.

The Visual Vectors Server software runs on the same platform as 
CentreVu CMS and supports CentreVu Visual Vectors clients. Using the 
client software, administrators can change certain properties of call center 
entities (such as their names), as well as create and edit vectors, assign 
VDNs to vectors, and set VDN Skill Preferences.

CentreVu CMS/Visual Vectors Server interfaces with the Sun Microsystems, 
Inc. Solaris operating system and uses several Sun Microsystems, Inc. 
Solaris system utilities to:

• communicate with CMS terminals and printers

• communicate with PCs running CentreVu Supervisor and CentreVu 
Visual Vectors client software

• log errors

• execute processes.

In this section This section includes the following information:

• Platforms and Required Software (1-3)

• Supported Switches (1-5)
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............................................................................................................................................................................................................................................................
Platforms and Required Software

Supported server
hardware platforms

Visual Vectors Server 8.0 software is certified to run on the following 
computers:

• Sun Microsystems, Inc. Sun Enterprise 3000

• Sun Microsystems, Inc. Sun Enterprise 3500

• Sun Microsystems, Inc. Sun Ultra 5

• Sun Microsystems, Inc. Sun SPARCserver 20

• Sun Microsystems, Inc. Sun SPARCserver 10

• Sun Microsystems, Inc. Sun SPARCserver 5.
CentreVu CMS running on the Sun Microsystems, Inc. Sun SPARCserver 
5 platform supports a combination of up to 128 terminals and printers. 
CentreVu CMS running on the Sun Microsystems, Inc. Sun SPARCserver 
20 platform or the Sun Microsystems, Inc. Sun Enterprise 3000 or Sun 
Microsystems, Inc. Sun Enterprise 3500 supports a combination of up to 
256 terminals and printers.

Recommended Client PC
configuration

The recommended PC configuration required for CentreVu Visual Vectors 
8.0 client software is the following:

• Intel Corporation Pentium or compatible processor, running at 200 
MHz or faster (the minimum supported processor speed is 133MHz; 
however, performance may be unsatisfactory)

• A hard disk drive with 50 MB of free space.

• A CD-ROM drive

• 64 MB or more of RAM (the minimum supported amount of physical 
memory is 48MB). If simultaneous instances of Visual Vectors 
software's tool windows are running, additional memory may be 
required to maintain acceptable performance

• A video monitor and adapter set to at least 800x600x256 colors 
graphics resolution

• Microsoft Corp. Windows 95, Microsoft Corp. Windows 98, or 
Microsoft Corp. Windows NT 4.0 operating system (with Service Pack 
4 or later)

Note: The required browser for CentreVu Visual Vectors on-line help 
system is Microsoft Corp. Microsoft Internet Explorer 3.02 or later. 
Before installing CentreVu Visual Vectors, ensure that Microsoft 
Corp. Microsoft Internet Explorer 3.02 or later is correctly installed; 
however, it does not need to be set as your default browser or .htm 
application.
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• A mouse or other pointing device compatible with one of the 
supported Microsoft Corp. Windows operating systems

• For Network Connection:

– WinSock 1.1 compliant TCP/IP stack

– Xerox Corp. Ethernet communications board.

Required software for a
Sun Microsystems, Inc.

Sun server platform

CentreVu CMS/Visual Vectors Server requires the following software 
packages to operate properly:

• An appropriate load of CentreVu CMS R3V6 or later (see your server 
documentation for the supported loads)

• An appropriate release of the Supplemental Services CD, Version 1.0

• Sun Microsystems, Inc. Solaris 2.5.1.

• Sun Microsystems, Inc. Sun Common Desktop Environment 1.0.2

• Sun Microsystems, Inc. SunLink X.25 Network Interface 9.1 (if using 
an X.25 connection to the switch)

• 1.0 Network Terminal Server (to support CMS terminals and printers) 

The Sun Microsystems, Inc. Solstice DiskSuite software package allows 
the disks of a Sun Microsystems, Inc. Sun SPARCserver system to be 
managed as if they were a single file system. This software is included in 
all new CentreVu CMS R3V8 installations.

Required software for a
Windows client platform

CentreVu Visual Vectors software runs under Microsoft Corp. Windows 95/
98 or Microsoft Corp. Windows NT 4.0. When running under Microsoft 
Corp. Windows NT 4.0, CentreVu Visual Vectors 8.0 client software 
requires Service Pack 4 or later to be installed.

Note: The required browser for CentreVu Visual Vectors on-line help 
system is Microsoft Corp. Microsoft Internet Explorer 3.02 or later. Before 
installing CentreVu Visual Vectors, ensure that Microsoft Corp. Microsoft 
Internet Explorer 3.02 or later is correctly installed; however, it does not 
need to be set as your default browser or .htm application.
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............................................................................................................................................................................................................................................................
Supported Switches

Switch names and
releases

CentreVu CMS/Visual Vectors Server software is certified to run with the 
following releases of Lucent Technologies switches: 

• DEFINITY Enterprise Communications Server (ECS) Release 6.3

• DEFINITY ECS Release 7.

Single and multiple
ACDs

Depending on which computer you have and how the CentreVu CMS 
software was installed, the CentreVu CMS software can communicate with 
as many as eight ACDs. 

Depending on how the Visual Vectors Server software was installed and 
configured, the CentreVu Visual Vectors 8.0 client software can 
communicate with as many as 20 CentreVu CMS/Visual Vectors servers.

References to multiple ACDs in this document refer to multiple-switch 
configurations. If you have only one switch, you can ignore multiple-ACD 
considerations. 
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............................................................................................................................................................................................................................................................
Prerequisite Switch and CentreVu CMS Features

Overview CentreVu CMS includes a feature for administering automatic call 
distribution (ACD) and optional features for managing aspects of the 
system. The features required to use CentreVu Visual Vectors software 
are described below.

ACD Administration and
Visual Vectors

CentreVu CMS/Visual Vectors software provides an administrative 
interface to the switch. The CentreVu CMS software supports CentreVu 
Supervisor clients. Using the Agent Administration and Call Center 
Administration areas, administrators can use CentreVu Supervisor to view 
or change various ACD-, Vectoring-, and Expert Agent Selection (EAS)-
related parameters on the switch, and to run reports that describe your call 
center configuration. For example, you can add agents to or remove 
agents from splits or skills; move extensions between splits; change skill 
assignments; change trunk group-to-split, trunk group-to-VDN, or VDN-to-
vector assignments; start an agent trace and list the agents being traced.

The Visual Vectors Server software supports CentreVu Visual Vectors 
clients. Using the CentreVu Visual Vectors client software, administrators 
can change certain properties of call center entities, as well as create and 
edit vectors, assign VDNs to vectors and set VDN Skill Preferences.

The CentreVu CMS/Visual Vectors administrator should coordinate with 
the ECS/switch administrator to be sure that the needed ACD/CMS 
configuration is understood by both people. 

Vectoring and Visual
Vectors

The CentreVu CMS Call Vectoring feature enables you to create, copy, 
and edit vectors on any ECS. Call vectors are user-defined, call-
processing programs. Call vectors direct calls to specified on-network or 
off-network destinations, to queues in ACD splits, or to treatments such as 
music, recorded announcements, forced disconnect, and forced busy. 
CentreVu Visual Vectors provides a visually rich, intuitive graphical 
interface for this feature for call centers with DEFINITY ECS R6.3 or 7 and 
CentreVu CMS R3V6 and R3V8 servers.

On the ECS/switch and CentreVu CMS, the Call Vectoring feature is a 
separately purchased feature that is required to use Visual Vectors 
software. 
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Things to Know Before Using 
Visual Vectors

............................................................................................................................................................................................................................................................
Overview

Purpose This section describes what you should know before using the CentreVu 
Visual Vectors software.

In this section This section includes the following information:

• Interactions With CentreVu Supervisor (1-8)

• Interactions With CentreVu CMS (1-9)
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............................................................................................................................................................................................................................................................
Interactions With CentreVu Supervisor

Overview CentreVu Visual Vectors software is designed to work with CentreVu 
Supervisor Version 6 or later.

Interactions with
CentreVu Supervisor

If CentreVu Supervisor Version 6 or later is correctly installed on your 
client PC, then Visual Vectors software will display a toolbar icon and 
menu item. You can use these features to start CentreVu Supervisor 
software. 

Other than the ability to run it, CentreVu Visual Vectors and CentreVu 
Supervisor do not interact directly. If information from the two software 
programs does not seem to match, first try to log off the CentreVu CMS 
server in each program, and then log back on.

Using CentreVu
Supervisor

Use CentreVu Supervisor software to do the following:

• Generate reports on the VDNs, vectors and skill preferences you 
have assigned using CentreVu Visual Vectors tools.

• Assign names to splits/skills, trunk groups, ACDs, and Vectors/VDNs 
in the CentreVu CMS Dictionary, so that the objects in your Call 
Center World will have more meaningful names.

See CentreVu Supervisor Version 8 Installation and Getting Started, 585-
210-928 and CentreVu Call Management System Release 3 Version 8 
Administration, 585-210-930 for more information.
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............................................................................................................................................................................................................................................................
Interactions With CentreVu CMS

Overview CentreVu Visual Vectors software is designed to work with CentreVu CMS 
R3V6 or later.

Interactions with
CentreVu CMS R3V8

If information obtained from the two client software programs does not 
seem to match, log off the CentreVu CMS R3V8 server from each client 
software program, and then log back on.

Important! Edit vectors only in Visual Vectors. If you use any other 
way to edit vectors, such as a CMS terminal, the comments will be 
converted to floating comments.

Using CentreVu
Supervisor

CentreVu Visual Vectors software is designed to work with CentreVu 
Supervisor Version 6 or later. Use CentreVu Supervisor software to do the 
following:

• Generate reports on the VDNs, vectors and skill preferences you 
have assigned using CentreVu Visual Vectors tools.

• Assign names to entities such as splits/skills, trunk groups, ACDs, 
and Vectors/VDNs in the CentreVu CMS Dictionary. You can use the 
Navigator tool in CentreVu Visual Vectors to give more meaningful 
names to these objects in your Call Center World.

See CentreVu Supervisor Version 8 Installation and Getting Started, 585-
210-928 and CentreVu Call Management System Release 3 Version 8 
Administration, 585-210-930 for more information.
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Terminology

............................................................................................................................................................................................................................................................
Overview

Purpose This section describes the terms you need to know before you begin using 
Visual Vectors software. These terms, as well as others, are also defined 
in the Glossary.
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............................................................................................................................................................................................................................................................
Terms You Need to Know

Terms You need to know the following terms to understand how to use the 
software. 

Access Permissions  Permissions assigned to a user so that the user 
can access different areas of a server or administer specific entities (for 
example, splits/skills, trunk groups, vectors, and VDNs) of an ACD. 
Access permissions are specified as read or write permission. Read 
permission means the user can access and view data. Write permission 
means the user can add, modify, or delete data and execute processes.

Automatic Call Distribution (ACD)  A switch feature using software that 
channels high-volume incoming and outgoing call traffic to agents grouped 
in splits or skills. 

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Center World   A collection of objects and entities that can be viewed 
and administered through CentreVu Framework. What you can access, 
edit or assign depends on your permissions.

CentreVu Call Management System (CMS)   A software product used 
by business customers that have Lucent Technologies 
telecommunications switches/ECS and receive a large volume of 
telephone calls that are processed through the Automatic Call Distribution 
(ACD) feature of the switch/ECS. The CMS collects call-traffic data, 
formats management reports, and provides an administrative interface to 
the ACD feature in the switch/ECS.

CentreVu Framework   The Visual Vectors software window from which 
you access tools such as Navigator, Vector Editor, and VDN Assignment. 
You can also use Framework File menu items to Connect to or Disconnect 
from CentreVu CMS servers. 

CentreVu Supervisor  The Call Management System client application 
for the Microsoft Corp. Windows operating environment.

Dictionary  An area of CMS that can be used to assign names to various 
call center entities such as login IDs, splits/skills, trunk groups, VDNs and 
vectors. These names make call center data easier to interpret.

Entity   A generic term that refers to one of the following: Announcement, 
Split/Skill, Trunk Group, VDN, or Vector. Entities that CentreVu Visual 
Vectors can view or administer include Vectors and VDNs. Entity names 
are obtained from the CentreVu CMS Dictionary; renaming entities using 
Visual Vectors results in changes to the CMS Dictionary.
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Expert Agent Selection (EAS)  Expert Agent Selection (EAS) is an 
optional switch feature that builds on the power of the Call Vectoring and 
ACD features of the switch to match the skills required to handle a 
particular call to an agent who has at least one of the skills that a caller 
requires. The ACD queuing and the Queue and Check   vector 
commands are used to route a call to an agent with the appropriate skill to 
handle that call. With EAS, call distribution is based on skill.

CentreVu CMS collects data on skills in the same manner as it collects 
data on splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that 
customers can assess the call center performance relative to calls 
requiring particular skills. CMS reports how many calls were handled, how 
long these calls waited for service, and the average talk time for calls 
queued to a particular skill preference in a particular VDN.

Navigator   The window that displays after you select it from the Tools 
menu or toolbar in the CentreVu Framework window. It consists of two 
panes: a hierarchical “tree” view of your Call Center World on the left and a 
list of objects or entities on the right.

User Permissions  An area of the CentreVu CMS server that allows the 
administrator to define what each user can access.

VDN Assignment Wizard   A series of dialogue boxes that displays after 
you select it from the Tools menu or toolbar. It consists of several steps 
presented in the dialogue boxes; for example, one filters and selects the 
VDNs you wish to assign, and another performs the assignment(s).

Vector Directory Number (VDN)  An extension number that enables calls 
to connect to a vector for processing. A VDN is not assigned an equipment 
location. It is assigned to a vector. A VDN can connect calls to a vector 
when the calls arrive over an assigned automatic-in trunk group or when 
calls arrive over a dial-repeating (DID) trunk group and the final digits 
match the VDN. The VDN by itself may be dialed to access the vector from 
any extension connected to the switch. 

Vector Editor   This software tool, accessed from CentreVu Framework, 
allows you to create and edit vectors visually, by dragging and dropping 
icons representing commands from a palette and arranging them into 
vector steps in a work area. You can attach comments, change layout, and 
save and print the vectors.

Vector Step  One processing step in a vector. A vector step consists of a 
command and one or more conditions or parameters. These conditions or 
parameters are found on a step's Properties window in Visual Vectors 
client software.
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Vector Step Condition  A condition accompanying a vector command 
that defines the circumstances in which the command will be applied to a 
call. These conditions are found on a step’s Properties window in Visual 
Vectors client software. 

Visual Vectors Client   Client software which provides a rich, graphical 
user interface for creating or modifying configured elements of ACDs 
connected to a CMS. This software can be loaded directly on the user’s 
personal computer or downloaded from a network.

Visual Vectors Server   Server software which enables administration 
(changing or modifying configured elements) for ACDs connected to a 
CMS. This software resides on the CMS server.
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Things to Know About Call Center 
Data

............................................................................................................................................................................................................................................................
Overview

Purpose This section describes the CentreVu CMS processes for storing and 
tracking switch (ACD) data for your call center. The information is intended 
to give you an overview of how CentreVu CMS works, and where 
CentreVu CMS stores data. Visual Vectors Server software accesses 
CMS Dictionary and User Permissions data.
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............................................................................................................................................................................................................................................................
How CentreVu CMS Stores and Tracks ACD Data

Real-time and historical
databases

CentreVu CMS stores the ACD data received from the switch in the real-
time and historical databases. Within each of these databases, CentreVu 
CMS stores the specific ACD data for agents, splits/skills, trunks, trunk 
groups, vectors, and VDNs in separate database tables. Call work codes 
(CWC) also have separate database tables in the real-time and historical 
database.

Summarizing CMS Data As CentreVu CMS collects the real-time data from the ACD, the data is 
stored in the current intrahour interval tables (agent, split/skill, trunk, trunk 
group, vector, and VDN) until the end of the interval. At the end of the 
current intrahour interval, data is archived to the previous intrahour interval 
tables and to the intrahour historical tables. At your designated data 
summarizing time, the historical intrahour data is summarized into daily 
data. At the end of your designated week (as specified on the System 
Setup subsystem Storage Intervals window), the daily data is summarized 
into weekly data. On the first day of a new month, monthly summaries are 
generated from the daily data for the previous month.

CMS Dictionary The CMS Dictionary contains names for call center ACDs and their 
entities, including announcements, splits/skills, trunk groups, VDNs, and 
vectors. The assigned names appear on CMS reports to make them easier 
to interpret, as well as in Visual Vectors software to make it easier to use. 
You can use Visual Vectors tools to rename entities, or edit certain other 
properties of them (for example, their descriptions). See CentreVu Call 
Management System Release 3 Version 8 Administration, 585-210-930 for 
more information about CentreVu CMS Dictionary.

User Permissions Visual Vectors software determines what users can view and modify 
based on CMS User Permissions. For example, if a user has read access 
for an ACD and/or its vectors but no write access, the user will not be able 
to use Vector Editor to save, or Navigator to copy, a vector to that ACD. 
Likewise, if a user has no read or write access permissions for a type of 
entity (for example, VDNs), then the folder for those entities on the ACD 
will appear empty in Navigator. See CentreVu Call Management System 
Release 3 Version 8 Administration, 585-210-930 for more information 
about CentreVu CMS User Permissions.

Important!  If more than 2,000 VDNs have been authorized on a 
CentreVu CMS R3V6 server, then VDN permission checking 
(enabled through User Permissions’ VDN Access operation) is not 
available.
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Prerequisite System Administration

............................................................................................................................................................................................................................................................
Overview

Purpose  This section describes system administration required before you can run 
CentreVu Visual Vectors software.

In this section This section consists of the following information:

• Configuring Visual Vectors Server (1-17)

• CentreVu Visual Vectors Training (1-20)
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............................................................................................................................................................................................................................................................
Configuring Visual Vectors Server

Overview Typically, an administrator will have installed and configured the CentreVu 
Visual Vectors Server. However, if you need to install and configure the 
server, first refer to the CentreVu CMS R3V8 Upgrades and Migration, 
Issue 1, 585-210-913 for instructions on how to proceed. A brief outline 
follows of the procedures to install the CentreVu Visual Vectors Server 
software package.

How to install Visual
Vectors Server software ...............................................................................................................................................................................

1 Log in as root.

Result:  You are ready to begin installing the software package.

...........................................................................................................................................................................

2 Insert the CD-ROM and enter the following command: /usr/sbin/
pkgadd -d /cdrom/cdrom0.

Result:  The system displays information about the CD contents.

...........................................................................................................................................................................

3 Enter option 1 or press Return to select Visual Vectors Server software 
for processing.

Result:  The system queries if you wish to continue.

...........................................................................................................................................................................

4 Enter y to continue installation.

Result:  The CD package information is re-displayed.

...........................................................................................................................................................................

5 After verifying this information, enter q at the prompt.

Result:  The installation process ends.

E N D  O F  S T E P S....................................................................................................................................................................................
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How to initially set up
your server software ...............................................................................................................................................................................

1 At the system prompt, enter the following command: setupaas

...........................................................................................................................................................................

2 Select option 1 from the displayed setup menu.

...........................................................................................................................................................................

3 Enter the number of allowable concurrent logins. The maximum number 
is the number of purchased licenses.

E N D  O F  S T E P S....................................................................................................................................................................................

How to start Visual
Vectors Server software ...............................................................................................................................................................................

1 At the system prompt, enter the following command: setupaas

...........................................................................................................................................................................

2 Select option 2 from the displayed setup menu.

...........................................................................................................................................................................

3 Select option 1 from the turn on/stop menu to start the software.

E N D  O F  S T E P S....................................................................................................................................................................................

Server performance The following table summarizes capacity limits for CMS hardware 
platforms running CentreVu Visual Vectors Server software:

Simul-
taneous 
realtime 
reports

Historical
, 
forecasti
ng, ICH, 
and agent 
trace 
reports 
per hour

ODBC 
reports 
per hour

Web 
hits per 
hour

VDNs on 
any 
single 
ACD

Sparc 5 200 80 80 40,000 1300

Ultra 5 300 120 120 60,000 1950

UE3000 
(1CPU)

400 160 160 80,000 2600
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Delay estimates The following table estimates the delay (in seconds) to navigate VDNs for 
some CMS hardware platforms running CentreVu Visual Vectors Server 
software:

UE300 
(2CPUs)

800 320 320 160,000 5200

E3500 
(2CPUs)

1200 480 480 240,000 7800

E3500 
(4CPUs)

2400 960 960 480,000 15,600

Simul-
taneous 
realtime 
reports

Historical
, 
forecasti
ng, ICH, 
and agent 
trace 
reports 
per hour

ODBC 
reports 
per hour

Web 
hits per 
hour

VDNs on 
any 
single 
ACD

VDNs 250 500 1000 2000 4000 8000

Sparc 5 9.0 14.1 24.4 45.0 86.2 168.6

Ultra 5 5.8 9.0 15.6 28.8 55.2 107.9

UE3000 
(1 CPU)

4.5 7.1 12.2 22.5 43.1 84.3

UE300 
(2CPUs)

2.3 3.6 6.1 11.3 21.6 43.2

E3500 
(2CPUs)

1.5 2.4 4.1 7.6 14.6 28.6

E3500 
(4CPUs)

0.8 1.2 2.1 3.8 7.3 14.3
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............................................................................................................................................................................................................................................................
CentreVu Visual Vectors Training

Training included with
software

If you are a U.S. customer, your Lucent Technologies Project Manager 
should call 1-800-255-8988 to schedule the appropriate classes for you. 
For training outside the United States, contact your local Lucent distributor 
or representative. 

Available courses The available training courses are shown in this table.

Course 
Number

PEC Course Name Description

 BTC124H 1460-
057

DEFINITY 
ECS with EAS

A 4-day course that provides 
training on the tasks required to 
set up a G3 switch with the EAS 
feature and design vectors.

 BTC138H DEFINITY 
ECS G3 ACD 
with Vectoring 

A 4-day course that provides 
training on the tasks required to 
set up a CentreVu CMS call center 
application with the G3 switch and 
the EAS feature, administer 
CentreVu CMS, interpret reports 
on ACD activity, and use the 
Vectoring and Forecast features. 

 
BTC429M

1470-
016a

DEFINITY 
ACD and 
Vectoring

This CD-ROM course lasts 
approximately 1.5 hours. It 
provides hands-on experience 
administering the ACD feature with 
vectoring.

 BTC155H 1462-
031

CentreVu 
Supervisor 
Administration 
with EAS

A 4.5 day class that provides 
training on the tasks required to 
administer CentreVu CMS using 
CentreVu Supervisor, interpret 
reports of ACD activity in the 
CentreVu Supervisor Interface and 
use the vectoring and forecasting 
features in the CMS interface.
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 BTC154H 1462-
030

CentreVu 
Supervisor 
Administration 

A 4.5 day class that provides 
training on the tasks required to 
administer CentreVu CMS using 
CentreVu Supervisor, interpret 
reports of ACD activity in the 
CentreVu Supervisor Interface and 
use the vectoring and forecasting 
features in the CMS interface.

BTC447M 1472-
006

CentreVu 
Supervisor V6 
Administration 

 (with and 
without EAS)

This CD-ROM course lasts 
approximately four hours. It covers 
the tasks required to administer 
CMS and how to use the CentreVu 
Supervisor tools. This course 
includes system simulations, 
hands-on exercises and 
supporting material.

 BTC115H 1462-
014

CentreVu CMS 
Custom 
Reports

A 3 day class that provides training 
on the tasks required to develop 
CMS custom reports.

 
BTC450M

1472-
005

CentreVu 
Advocate: 
Breakthrough 
Solutions 

This CD-ROM course lasts 
approximately 4 hours. It teaches 
how to use CentreVu Advocate to 
better manage their Call Center 
Resources. This course includes 
system simulations, hands-on 
exercises and support material.

BTC467M not 
listed

CentreVu 
Visual Vectors 
User Training

This CD-ROM course lasts 
approximately 2 hours. It teaches 
how to uses Visual Vectors to 
create vectors and how to assign 
VDNs to vectors. The course 
includes system simulations, 
hands-on exercises and 
supporting material.

Course 
Number

PEC Course Name Description
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Course notes

Price Elements Codes (PECs) should be used only to enroll additional 
persons (those who are not the two persons to receive training at no 
additional charge).

The last lesson (the last half-day) in the Administration courses covers the 
Forecast feature. Also, the student can view the CentreVu Visual Vectors 
User Training CD-ROM. If you have not purchased the Forecast or 
Vectoring features, you do not have to attend this session.

Other  training 

You may benefit by taking additional courses (available at additional 
charges) in the following subject areas: 

• Traffic Theory/Data Analysis

• Host Computer Administration

• Switch Administration.

You automatically receive the following Individualized Learning Programs 
(booklets) after one of your call center's employees is enrolled in the 
CentreVu CMS Administration course:

• ACD Fundamentals

• Vectoring and EAS Basics.
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2 Setting Up Your Call 
Center World

............................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to set up the Call Center World seen in the 
Navigator.

It is divided into the following sections:

• Call Center World Overview

• Adding and Deleting Objects in the Call Center World

• Call Center World Objects

• Call Center World Object Properties.

See the overview to each section for a preview of the section's contents.
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Call Center World Overview

............................................................................................................................................................................................................................................................
Overview

Purpose To use the Visual Vectors software, you need to set up a Call Center 
World. A number of ACD, CentreVu CMS and CentreVu Supervisor terms 
must be understood to set up your Call Center World.
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............................................................................................................................................................................................................................................................
Terms You Need to Know

Terms Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys    Keys that provide shortcuts to actions available on 
the menu.

CentreVu Visual Vectors window   The window in which you are 
currently working (usually indicated by a highlighted title bar). Visual 
Vectors has a Framework window and windows for each of the tools, 
including Navigator, Vector Editor, and VDN Assignment.

Container   An object in your Call Center World that logically contains 
other entities or objects. For example, each CMS object in your Call 
Center World can contain as many as 8 ACD objects, each of which 
contains entity folders (for announcements, split or skill objects, trunk 
groups, VDNs, and vectors).

Context menu   A menu with specific actions for an entity or item.

Entity   A generic term that refers to one of the following: Announcement, 
Split/Skill, Trunk Group, VDN, or Vector. Entities that CentreVu Visual 
Vectors can view or administer include Vectors and VDNs. Entity names 
are obtained from the CentreVu CMS Dictionary; renaming entities using 
Visual Vectors results in changes to the CMS Dictionary.

Folder   An object in the Navigator tool that contains entities 
(announcements, splits/skills, trunk groups, VDNs, and vectors). Folders 
are used to visually group all entities of a specific type for an ACD.

Input field   An area in a window into which you enter one or more valid 
values. Valid values may be integers, for example, or names assigned in 
the CentreVu CMS Dictionary.

Menu bar   A menu bar is under the title bar of most windows. The menu 
bar shows the menu names available for that particular window (for 
example, File and Help). You select an item from one of these drop-down 
menus.

Navigator   A window that displays after you select it from the Tools menu 
or toolbar in the CentreVu Framework window. It consists of two panes: a 
hierarchical “tree” view of your Call Center World on the left and a list of 
objects or entities on the right.
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Object   Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administrable entity itself (VDN).

Status bar   A status bar is across the bottom of some windows. The 
status bar shows information about the current action in that window.

Title bar   A title bar is across the top of most windows. The title bar shows 
the name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar   A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tooltips   Tooltips are available in most windows by placing the mouse 
cursor over an item for two seconds. Tooltips usually describe the actions 
performed by selecting an icon. Tooltips can be disabled on the 
Preferences window accessed from the Tools menu of CentreVu 
Framework.

VDN Assignment Wizard   A series of dialogue boxes that displays after 
you select it from the Tools menu or toolbar. It consists of several steps 
presented in the dialogue boxes; for example, one filters and selects the 
VDNs you wish to assign, and another performs the assignment(s).

Vector Editor   This software tool, accessed from CentreVu Framework, 
allows you to create and edit vectors visually, by dragging and dropping 
icons representing commands from a palette and arranging them into 
vector steps in a work area. You can attach comments, change layout, and 
save and print the vectors.
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Adding and Deleting Objects in the 
Call Center World

............................................................................................................................................................................................................................................................
Overview

Purpose This section describes how you add or delete objects in your Call Center 
World.

In this section Topics in this section include:

• Basic Framework window features

• Basic Navigator window features

• Using Visual Vectors window

• Adding new Centre Vu CMS servers

• Adding objects

• Selecting objects and performing actions

• Deleting objects

• Renaming objects

• Changing other object properties

• Rules for field entry
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............................................................................................................................................................................................................................................................
Basic Framework Window Features

Overview This section describes the features of the CentreVu Framework window in 
the Visual Vectors software.

Framework window The following figure shows CentreVu Framework window:

System menu box A common convention. The system menu box enables you to perform 
basic operations, such as closing the current window or software program. 

Title bar A common convention. The title bar shows the name of the tool. When a 
vector is open in the Vector Editor, its name is shown.

Minimize, maximize/
restore, and close

buttons

A common convention. The buttons adjust the size of the current window, 
or close it. 

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of what the button does. After you select a 
button, the status bar displays a description of the command that the 
particular button is performing. 

These buttons appear on the toolbar.

Button Function

Connect Initiates a connection to a CMS server.

Disconnect Disabled until you are connected to a CMS server.

Navigator Accesses the window for the Navigator tool. 

Vector Editor Accesses the window for the Vector Editor tool. 
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Status bar The status bar is located at the bottom of the CentreVu Framework and 
Vector Editor windows. Framework displays a brief description of what 
actions are occurring; Vector Editor displays the number of steps in the 
current vector. 

Menu bar A common convention. The menu bar lists the available drop-down 
menus. This section identifies the menus that are available before you log 
into the CMS server: File, Tools, Window, and Help.

File menu
Connect/Disconnect

windows

The following figure shows the Connect to Server window that displays 
from the file menu:

VDN Assignment 
Wizard

Accesses the first of a series of dialogue boxes for the 
VDN Assignment Wizard tool. 

CentreVu 
Supervisor

Launches CentreVu Supervisor Version 6 or later, if that 
program is installed correctly. If not, this button does not 
appear.

Help Contents Launches the Help application window for Visual 
Vectors. 

Button Function
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The following figure shows the Disconnect window that displays from the 
file menu:

File Menu items From this menu, you can initiate or discontinue a connection to a CMS 
server. The menu has the following items.

Connect  Displays the Connect to server window.

You can select from the drop-down list of servers to which you’ve 
previously connected, or select the New CMS button to identify a new 
server to log into and add to your Call Center World.

Disconnect  Displays the Disconnect window listing servers to which you 
are connected.

Highlight the server(s) from which you wish to disconnect and select the 
Disconnect button or press the Enter key.

Exit  Automatically disconnects from any CMS servers to which you are 
connected and then closes CentreVu Framework window. A warning 
message appears if you have open tool windows.

Tools Menu Select the Tools menu to access the following items.

Navigator  Opens the window for the Navigator. You can view, add, 
delete, or move objects in your Call Center World using this window.

Vector Editor  Opens the window for the Vector Editor. You can create 
new or edit existing vectors in this window, and then save them to an ACD 
(if you have the needed permissions) or the scratchpad on your PC.
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VDN Assignment Wizard  Opens the first of a series of dialogue boxes 
for the VDN Assignment Wizard. This tool consists of dialogue boxes that 
lead you through a series of steps. It enables you to assign VDNs to 
vectors and VDN skill preferences. You can also view which VDNs are 
assigned to which vectors and, if necessary, change those assignments.

CentreVu Supervisor (if installed correctly)  Launches a separate 
session of CentreVu Supervisor. Other than this shortcut, the two 
programs are autonomous.

Preferences...  Opens the Preferences window. You can view or modify 
settings such as Locale and whether Tooltips are enabled.

Advanced Debugging...  Used for debugging. Do not change the settings 
on the Advanced window unless you are instructed to do so by a Lucent 
Technologies assistant.

Window Menu Select Window from the menu bar to choose from the following items.

Close All  Closes the windows of all open tools, but leaves the CentreVu 
Framework window open and Visual Vectors software running.

Window List  Makes the selected Visual Vectors tool the current window.

Help Menu Press the F1 key or select the Help button to display help on a window or 
tool. Select Help from the menu bar to choose from the following options.

Help Contents  Opens the Help window, and displays the Visual Vectors 
table of contents. 

About…  Displays the About CentreVu Visual Vectors… window, which 
shows the software build number. 
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............................................................................................................................................................................................................................................................
Basic Navigator Window Features

Overview Whether you are logged into a CMS server and your CentreVu CMS/
Visual Vectors user permissions determines the objects shown in 
Navigator and the menu items and toolbar buttons available to you for 
those objects.

Navigator Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs and a 
tooltip.

The default Navigator toolbar buttons are as follows: 

Button Function

Up One Level Makes the parent of the current object the new current 
object. 

New Creates a new object (scratchpad or vector) within the 
current object.

Delete Deletes the currently selected object. 

Rename Enters the edit mode on the name property of the selected 
object. 

Properties Displays the Property window for the current object(s). 

Undo Undoes the last action performed in this window. 

Redo Performs the last action undone in this window. 

Cut Removes the selected object(s) to be pasted later.

Copy Copies the selected object(s) to be pasted later.

Paste Pastes the previously cut or copied object(s) into the 
current folder.

Details Changes the view in the right-hand pane from a list of 
object icons to one row of data per object. 

List Changes the view in the right-hand pane from one row of 
data per object to a list of object icons. 

Help Contents Starts the Help system and displays the default page. This 
function may take several seconds.
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Status indicators These indicators in the Navigator tell you about the state of a CMS server 
and its measured ACDs.

Menu bar This section identifies the four menus that are available after you log into a 
CMS server: File, Edit, View, and Help.

File Menu The File menu has the following items.

New  Creates a new object in your Call Center World.

Delete  Removes an object from your Call Center World.

Rename  Enters the editing mode for the name property of the selected 
object.

Properties  Accesses the Properties window for the selected object.

Close  Closes the current window.

Edit Menu The Edit menu has the following items.

Undo  Undoes the last action performed in this Navigator session.

Redo  Redoes the last action that was undone in this Navigator session.

Cut  Removes the selected object to be pasted later.

Copy  Copies the selected object to be pasted later.

Paste  Pastes the object that was previously cut or copied.

View Menu The View menu has the following items.

Up One Level  Highlights the “parent” object of the selected object in the 
left pane, displaying the parent object's contents in the right pane.

Details  Changes the information displayed in the right pane for objects 
selected in the left pane. Details view is the default, showing one row for 
each object contained in the object selected in the left pane. Each row 
contains columns for the Name, Type, and your read/write Permissions of 
the object.

This indicator 
…

Displays …

Login status The icon for the CMS object in Navigator displays a 
black screen if you are not connected.

ACD link status Icons for the ACDs that are supported by the CMS. If the 
link to an ACD is down, the icon is crossed out. If the 
CMS server is connected to the ACD via a TCP/IP 
connection and the connection is in a transient state, the 
icon changes to a straight line.
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List  Changes the information displayed in the right pane for objects 
selected in the left pane. List view shows one named icon for each object 
contained in the object that is selected in the left pane.

Refresh  Refreshes and redraws the highlighted pane in the current 
window.

Help Menu Press the F1 key or select the Help button to display help on a window or 
tool. Select Help from the menu bar to choose from the following items.

Help Contents  Opens the Help window, and displays the Visual Vectors 
table of contents. 

About…  Displays the About CentreVu Visual Vectors… window, which 
shows the software build number. 
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............................................................................................................................................................................................................................................................
Using Visual Vectors Windows

Overview This section describes how to use features that are common to all Visual 
Vectors windows: the menus, toolbars, and Help system.

Visual Vectors menus To select a menu item, choose any of the following methods:

• Click on the item.

• Use the arrow keys to highlight the item and then press the Enter key.

• Hold down the Alt key and press the underlined letter in the menu 
item you want to select

• Press the key or combination of keys (usually the Alt key or the Ctrl 
key and a letter key) assigned to the operation. For example, use 
Ctrl+C to copy. 

Visual Vectors toolbars All items available on Visual Vectors toolbars are also available within the 
menus. To select a toolbar item, click on the icon.

Help system Press the F1 key or select the Help button to display help for a window. 
Select Help from the menu bar to choose from the help options described 
in Basic Framework Window Features (2-6).
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............................................................................................................................................................................................................................................................
Adding New CentreVu CMS Servers

Procedure To establish a connection with a new CentreVu CMS server (one that is 
not already in your Call Center World), complete the following steps:

...........................................................................................................................................................................

1 In the CentreVu Framework window, select Connect from the File menu 
or the toolbar, and then select New CMS  in the Connect to server 
window.

OR

In the Navigator window, highlight Call Center World in the left-hand pane, 
and then select New CMS from the File or context menu.

Result:  The New CMS window opens.

...........................................................................................................................................................................

2 Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. 

...........................................................................................................................................................................

3 Enter your CentreVu CMS login ID in the Login ID text box.

...........................................................................................................................................................................

4 Type your CMS password in the Password text box.
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...........................................................................................................................................................................

5 Select OK.

Result:  If the CMS server you entered:

• Exists and can be connected to — a new CMS object will be 
added to your Call Center World and you will be connected to this 
new server.

• Doesn't exist or cannot be connected to — an error message will 
be displayed showing the cause of the failure. 
Go to step 2.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Adding objects

PurposePurpose You may want to add an object (for example, a new vector for an ACD in 
the Vector Folder) in your Call Center World. First, select a container for 
the object (for example, Vector Folder) in a Navigator window.

Adding an object Do this procedure to add an object (a new vector or scratchpad) to your 
Call Center World. If you add or save a vector to the Vector Folder on a 
measured ACD it will be added to the CMS database.

...........................................................................................................................................................................

1 In the Navigator window, highlight a scratchpad or Vector Folder in the 
left-hand pane, and then select R6 Vector (EAS) , R6 Vector (EAS Non-
Prompting), R6 Vector (Non-EAS,), R6  Vector (Non-EAS Non-
Prompting), R8 Vector (EAS), R8 Vector (EAS Non-Prompting), R8 
Vector (Non-EAS,), or R8  Vector (Non-EAS Non-Prompting)from the 
context menu. If you highlighted a scratchpad, you can also select 
Scratch Pad from the menu.

Result:  A new vector window or a New ScratchPad window opens.

...........................................................................................................................................................................

2 Fill in the required information in the input field(s) on the window. For a 
new vector, a Name (and Id, if on an ACD) are required.
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...........................................................................................................................................................................

3 Select OK.

Result:  If the addition

• was successful, the new object will appear in the Navigator.

• failed, an error message will be displayed showing the cause of the 
failure. 

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Selecting objects and performing actions

Overview To perform any action on an object in your Call Center World, you must 
first select the object. To select an object, choose any of the following 
methods: 

• Click on the object

• Use the arrow keys to highlight the item and then press Enter

• To select the object that contains the currently selected object, select 
Up One Level  from the View menu or Navigator toolbar. 

Input window actions Use these input window features to do the following:

Feature Action

Menu bar Pull down a list of actions, edit options, and on-line help.

Toolbar action 
buttons

Click a button to perform an action.

Input fields Type in the information needed to complete an action.

Selection list View a list of the content you may enter in the input field.



  
Setting Up Your Call Center World CentreVu Visual Vectors User Guide Release 8

Deleting objects 2-19

............................................................................................................................................................................................................................................................
Deleting objects

PurposePurpose You may want to delete a CMS from your Call Center World or a vector 
from the CentreVu CMS database. To delete an object, first select it in a 
Navigator window.

Getting information Do this procedure if you need information from the CMS database before 
you delete the item.

...........................................................................................................................................................................

1 Select Properties from the File or context menu, select the Properties  
button on the toolbar, or press Alt+Enter.

...........................................................................................................................................................................

2 Locate the information for the item you want to delete and note the 
relevant information. 

...........................................................................................................................................................................

3 Close the Properties window. 

Result:  The Navigator window displays.

E N D  O F  S T E P S....................................................................................................................................................................................

Deleting an object Do this procedure to delete an object (a CMS or vector) from your Call 
Center World. 

...........................................................................................................................................................................

1 Select the object.

...........................................................................................................................................................................

2 Select Delete from the File or context menu, select the Delete button on 
the toolbar, or press Delete.

Result:  If the deletion

• was successful, the contents of the object will be deleted and 
replaced with an empty vector in the Dictionary.

• failed, an error message will be displayed showing the cause of the 
failure. 

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Renaming objects

PurposePurpose You may want to rename an object that already exists in your Call Center 
World. First, select the object to be renamed.

Getting information Do this procedure if you need information from the CMS database before 
you rename the item.

...........................................................................................................................................................................

1 Select Properties from the File or context menu, select the Properties  
button on the toolbar, or press Alt+Enter.

Result:  The Properties of an object window appears.

...........................................................................................................................................................................

2 Locate and note the relevant information. For example, verify the Type 
of the Vector you want to rename.

...........................................................................................................................................................................

3 Close the Properties window. 

Result:  The Navigator window displays.

E N D  O F  S T E P S....................................................................................................................................................................................
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Renaming an object Do this procedure to rename an ACD object in the CMS database.

...........................................................................................................................................................................

1 Select the object.

...........................................................................................................................................................................

2 Select Rename from the File or context menu, or select the Rename 
button on the toolbar.

Result:  The Renaming object window displays with the Name property 
field highlighted.

...........................................................................................................................................................................

3 Type in the new name or edit the existing name and then select OK.

Result:  If the object was

• renamed, the new name appears in the Navigator.

• not renamed, an error message will be displayed showing the 
cause of the failure. 

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Changing other object properties 

PurposePurpose If you want to view or change the properties of one or more object(s), click 
on the Properties toolbar button or select the menu item in the Navigator. A 
Properties window will open, from which you can make your selection(s).

Single object If the property window is for a single object or entity (one split/skill, vector, 
VDN, or trunk group), a property window appears.

For split/skill, VDN, vector, trunk group and ACD, the window contains 
properties for an object for which you have permissions in the CMS 
Dictionary.
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Multiple objects If the property window is for multiple entities such as split/skills, vectors, 
VDNs, or trunk groups, a multiple-object property window appears.

For split/skill, VDN, vector, trunk group and ACD, the window contains 
properties for the objects for which you have permissions in the CMS 
Dictionary.

Changing properties ...............................................................................................................................................................................

1 Click on the Properties toolbar button or select the menu item in the 
Navigator.

Result:  A Properties window will open, in which you can edit certain 
item(s).

...........................................................................................................................................................................

2 Click in (or Tab  to) the property fields you want to change and edit the 
value in the field(s).

Result:  A red box will be drawn around property fields with invalid 
values.

...........................................................................................................................................................................

3 When you have made all your changes and no red boxes appear, select 
OK.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Rules for Field Entry 

Purpose When you change certain properties using Visual Vectors software, the 
CentreVu CMS server database  is updated. CMS has three classes of 
input field: name (synonym), description, and number. This section 
describes the rules that apply to each class.

Name A name (synonym) property field:

• Must begin with an alphabetic character. Characters are case 
sensitive.

• Can be 1 to 20 characters. Letters, numbers, underscores ( _), 
blanks, commas ( ,), periods ( .), and plus signs ( +) are valid. 

Description A description property field can be 1 to 50 characters. All keyboard 
characters are allowed except backslash ( \), grave accent ( ‘), tilde ( ~ ), 
double quotes ( "), pipe symbol ( |), asterisk ( *), and question mark ( ?).

Number A numeric entry can be a single value valid for the numeric property field.
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Call Center World Objects

............................................................................................................................................................................................................................................................
Overview

Purpose Objects include items on which you can perform actions in your Call 
Center World. The objects may be vectors, for example, or trunk groups or 
ACDs.

No matter which tool you use to select an object, the way in which you 
perform an action is the same. 

In this section Topics include:

• Objects in your Call Center World.
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............................................................................................................................................................................................................................................................
Objects in Your Call Center World

Overview The following describes all objects possible in your Call Center World.

• Call Center World object (2-26)

• ScratchPad object (2-27)

• CMS object (2-27)

• ACD object (2-28)

• Announcement Folder object (2-28)

• Announcement object (2-28)

• Split/Skill Folder object (2-28)

• Split/Skill object (2-28)

• Trunk Group Folder object (2-29)

• Trunk Group object (2-29)

• Vector Folder object (2-29)

• Vector object (2-30)

• VDN Folder object (2-30)

• VDN object (2-30)

Call Center World object The following describes the Call Center World object:

Actions Description

Explore Expands the Call Center World to show one or more CMS 
Servers for which you have read or read/write permission.

Disconnect All Displays the Disconnect window with all connected CMS 
servers highlighted.

Navigator Launches Navigator window with the Call Center World 
as place to start browsing.

New CMS Accesses the New CMS window to add a new server to 
your world.

Properties Displays properties of the Call Center World.
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ScratchPad object The following describes the ScratchPad object:

CMS object The following describes the CMS object:

Actions Description

Explore Expands the ScratchPad.

Navigator Launches Navigator window with the ScratchPad as place 
to start browsing.

New ScratchPad Creates a new ScratchPad.

New EAS Vector 
(R6 or R8)

Creates a new EAS Vector.

New Non-EAS 
Vector (R6 or R8)

Creates a new Non-EAS Vector.

New EAS, Non-
Prompting Vector 
(R6 or R8)

Creates a new EAS, Non-Prompting Vector.

New Non-EAS, 
Non-Prompting 
Vector (R6 or R8)

Creates a new Non-EAS, Non-Prompting Vector.

Cut Cuts the selected ScratchPad, to be pasted later.

Copy Copies an object, to be pasted later.

Paste Pastes an object, if there is one cut or copied.

Delete Deletes the ScratchPad. 

Rename Places user in edit mode for the ScratchPad name field in 
the Renaming ScratchPad window.

Properties Displays properties of the ScratchPad.

Actions Descriptions

Explore Expands the CMS object to show one or more ACDs for 
which you have read or read/write permission.

Connect Displays the Connect to server window for this CMS.

Disconnect Displays the Disconnect window with this CMS 
highlighted.

Navigator Launches Navigator window with the CMS as the place 
to start browsing.

Delete Removes the CMS from your Call Center World.

Properties Displays properties of the CMS.
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ACD object The following describes the ACD object:

Announcement Folder
object

The following describes the Announcement Folder object:

Announcement object The following describes the Announcement object:

Split/Skill Folder object The following describes the Split/Skill Folder object:

Split/Skill object The following describes the Split/Skill object:

Actions Descriptions

Explore Expands the ACD object to show folders of CMS entities.

Navigator Launches Navigator window with the ACD as the place 
to start browsing.

Rename Places you in edit mode for the ACD name field in the 
Renaming ACD window.

Properties Displays properties of the ACD.

Actions Descriptions

Explore Expands the Announcement Folder.

Navigator Launches Navigator window with the folder as place to 
start browsing.

Properties Displays properties of the Announcement Folder.

Actions Descriptions

Navigator Launches Navigator window with the announcement as 
place to start browsing.

Rename Places user in edit mode for the announcement name field 
in the Renaming announcement window.

Properties Displays properties of the announcement.

Actions Descriptions

Explore Expands the Split/Skill Folder.

Navigator Launches Navigator window with the folder as place to 
start browsing.

Properties Displays properties of the Split/Skill Folder.

Actions Descriptions

Navigator Launches Navigator window with the split or skill as 
place to start browsing.
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Trunk Group Folder
object

The following describes the Trunk Group Folder object:

Trunk Group object The following describes the Trunk Group object:

Vector Folder object The following describes the Vector Folder object:

Rename Places user in edit mode for the Split/Skill name field in 
the Renaming split/skill window.

Properties Displays properties of the Split/Skill.

Actions Descriptions

Actions Descriptions

Explore Expands the Trunk Group folder.

Navigator Launches Navigator window with the folder as place to 
start browsing.

Properties Displays properties of the Trunk Group folder.

Actions Descriptions

Navigator Launches Navigator window with the trunk group as 
place to start browsing.

Rename Places user in edit mode for the Trunk Group name field 
in the Renaming trunk group window.

Properties Displays properties of the Trunk Group.

Actions Descriptions

Explore Expands the Vector Folder.

Navigator Launches Navigator window with the folder as place to 
start browsing.

New Vector Creates a new vector with one Stop step in the folder.

Paste Pastes a vector if there is one cut or copied.

Properties Displays properties of the Vector Folder.
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Vector object The following describes the Vector object:

VDN Folder object The following describes the VDN Folder object:

VDN object The following describes the VDN object:

Actions Descriptions

Edit Accesses the Vector Editor tool to edit the vector.

View as ASCII Displays the vector in a window as plain text (read-only).

Navigator Launches Navigator window with the vector as place to 
start browsing.

Cut Copies a vector to memory and replaces it with a blank 
vector.

Copy Copies a vector to be pasted later.

Delete Deletes the vector from the folder for this ACD. This 
replaces it with a blank vector, and leaves the name in the 
Dictionary.

Rename Places user in edit mode for the Vector name field in the 
Renaming window.

Properties Displays properties of the vector.

Actions Descriptions

Explore Expands the VDN folder.

Navigator Launches Navigator window with the folder as place to 
start browsing.

Properties Displays properties of the VDN Folder.

Actions Descriptions

Navigator Launches Navigator window with the VDN as place to 
start browsing.

Rename Places user in edit mode for the VDN name field in the 
Renaming VDN window.

Properties Displays properties of the VDN.



  
Setting Up Your Call Center World CentreVu Visual Vectors User Guide Release 8

Call Center World Object Properties 2-31

Call Center World Object 
Properties

............................................................................................................................................................................................................................................................
Overview

Purpose Use object properties to change certain allowable parameters of:

• Any entities of the ACD, including announcements, splits/skills, trunk 
groups, VDNs, and vectors

• VDN administration (for example, its assigned vector and skill 
preferences)

In this section Topics include:

• Properties of Objects.
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............................................................................................................................................................................................................................................................
Properties of Objects

Overview The following describes the properties of all objects in your Call Center 
World. 

• Call Center World object (2-32)

• ScratchPad object (2-32)

• CMS object (2-33)

• ACD object (2-33)

• Announcement Folder object (2-34)

• Announcement object (2-34)

• Split/Skill Folder object (2-34)

• Split/Skill object (2-35)

• Trunk Group Folder object (2-35)

• Trunk Group object (2-35)

• Vector Folder object (2-36)

• Vector object (2-36)

• VDN Folder object (2-36)

• VDN object (2-37)

Call Center World object The following describes properties of the Call Center World object:

ScratchPad object The following describes properties of the ScratchPad object:

Properties Description

Name You cannot edit this name.

Type Type of object (World).

Permission Displays permission (R for read) you have for World.

Description Characters describing the Call Center World. You can edit 
this field.

Properties Description

Name  Name of a folder containing off-line vectors.

Type Type of object.

Permission Displays scratchpad permissions (read and write).

Description Characters describing the scratchpad object. You can edit 
this field.
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CMS object The following describes properties of the CMS object:

ACD object The following describes properties of the ACD object:

Properties Description

Name Name of the CentreVu CMS server. You cannot edit this 
name.

Type Type of CMS.

Permission Displays permissions (R for read, blank for none) you 
have for the CentreVu CMS server.

Version CentreVu CMS server software release and version 
numbers, for example R3V8.

Locale CentreVu CMS server software locale and time zone (for 
example, TZ GMT – 05:00).

Containee Count The number of objects (ACDs) contained within this 
object.

Properties Description

Name Name of the ACD in the CentreVu CMS Dictionary. You 
can rename it if you have ACD read and write access on 
the CMS.

Type Type of ACD

Permission Displays ACD permissions (read, write, or both) you 
have on the CentreVu CMS.

Id Number identifying the ACD on the CentreVu CMS.

Version DEFINITY server software release and version numbers, 
for example ECS R6.

Locale DEFINITY server software locale and time zone (for 
example, TZ GMT — 05:00).

Link Status Status (Link Up, Link Down) of the link to the ACD from 
CMS. The ACD icon is crossed out in Navigator if the 
link is down.

ACD Features Features enabled on the ACD, which could be EAS, 
Prompting, Vectoring.

Description Characters describing the ACD in the CMS Dictionary. 
You can edit this field.
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Announcement Folder
object

The following describes properties of the Announcement Folder object:

Announcement object The following describes properties of the Announcement object:

Split/Skill Folder object The following describes properties of the Split/Skill Folder object:

Properties Description

Name  Name of the folder containing announcements for this 
ACD.

Type Type of object.

Permission Displays announcement permissions (read, write, or both) 
you have for this ACD.

Containee Count Shows the number of announcements contained in the 
folder.

Properties Description

Name  Name of the announcement in the CMS Dictionary. You 
can rename it if you have read/write permissions. 

Type Type of object.

Permission Displays permissions (read, write, or both) for this 
announcement.

Extension Announcement extension number.

Description Characters describing the announcement in the CMS 
Dictionary. You can edit this field.

Properties Description

Name  Name of the folder containing measured splits or skills 
for this ACD.

Type Type of object.

Permission Displays split/skill permissions (read, write, or both) you 
have for this ACD.

Containee Count Shows the number of splits/skills contained in the folder.
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Split/Skill object The following describes properties of the Split/Skill object:

Trunk Group Folder
object

The following describes properties of the Trunk Group Folder object:

Trunk Group object The following describes properties of the Trunk Group object:

Properties Description

Name Name of the split/skill in the CentreVu CMS Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have for 
this split/skill.

Description Characters describing the split/skill in the CMS 
Dictionary. You can edit this field.

Properties Description

Name Name of the folder containing measured trunk groups for 
this ACD.

Type Type of object.

Permission Displays trunk group permissions (read, write, or both) 
you have for this ACD.

Containee Count Shows the number of trunk groups contained in the 
folder.

Properties Description

Name Name of the trunk group in the CentreVu CMS 
Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have for 
this trunk group.

Id Number identifying the trunk group on the CentreVu 
CMS.

Description Characters describing the trunk group in the CMS 
Dictionary. You can edit this field.
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Vector Folder object The following describes properties of the Vector Folder object:

Vector object The following describes properties of the Vector object:

VDN Folder object The following describes properties of the VDN Folder object:

Properties Description

Name Name of the folder containing measured vectors for this 
ACD.

Type Type of object.

Permission Displays vector permissions (read, write, or both) you 
have for this ACD.

Containee Count Shows the number of vectors contained in the folder.

Properties Description

Name Name of the vector in the CentreVu CMS Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have for 
this vector

Description Characters describing the vector in the CMS Dictionary. 
You can edit this field.

Id Number identifying the vector on the CentreVu CMS.

Step Count Shows the number of steps contained in the vector.

Properties Description

Name Name of the folder containing measured VDNs for this 
ACD.

Type Type of object.

Permission Displays VDN permissions (read, write, or both) you 
have for this ACD.

Containee Count Shows the number of VDNs contained in the folder.
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VDN object The following describes properties of the VDN object:

Properties Description

Name Name of the VDN in the CentreVu CMS Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have for 
this VDN.

Extension VDN extension number.

Vector Id Shows the number or synonym identifying the vector 
assigned to this VDN. You can change this assignment if 
you have VDN permissions on the CMS for the ACD.

Description Characters describing the VDN in the CMS Dictionary. 
You can edit this field.

Skill Pref Shows what skill preference(s) is(are) assigned to this 
VDN. You can change this assignment if you have VDN 
permissions on the CMS for the ACD (EAS only).
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3 Using Framework and 
Navigator 

............................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use CentreVu Framework and the Navigator 
tool.

It is divided into the following sections:

• Framework Software Overview

• How to Access Framework

• Selecting and Running Navigator

• Navigating Your Call Center World.

See the overview to each section for a preview of the section's contents.
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Framework Software Overview

............................................................................................................................................................................................................................................................
Overview

Purpose CentreVu Framework gives you access to all of the CentreVu Visual 
Vectors features and gives you the ability to manage any connections 
CentreVu Visual Vectors has to CentreVu CMS servers. This section gives 
an overview of this software.

In this section This section includes information you should know before starting the 
software:

• Framework's Features (3-3)

• Closing windows (3-4)

• Disconnecting and exiting the software (3-5)
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............................................................................................................................................................................................................................................................
Framework’s Features

Software functions CentreVu Framework has three main functions:

• To allow access to a set of tools, including the Navigator, Vector 
Editor, and VDN Assignment Wizard.

• To manage one or more connections to CentreVu CMS servers 
required to perform ACD actions such as renaming entities, saving 
vectors, and making VDN assignments.

• To help manage multiple tool windows.
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............................................................................................................................................................................................................................................................
Closing windows

How to close windows To close a window, select Close from the File menu, or press Alt+ F4.

To close all windows, select the Close All item on the Window menu from 
the CentreVu Framework window.



  
Using Framework and Navigator CentreVu Visual Vectors User Guide Release 8

Disconnecting and exiting the software 3-5

............................................................................................................................................................................................................................................................
Disconnecting and exiting the software

How to disconnect and
exit the software

To exit the software, select Exit from the File menu.

You may exit the software while connected to one or more CentreVu CMS 
server(s); Visual Vectors software disconnects you automatically before 
closing the CentreVu Framework window.

If you have open windows other than the CentreVu Framework window 
(such as the Vector Editor or Navigator tools), and you try to exit, a 
message displays. Select Yes to disconnect and exit.
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How to Access Framework

............................................................................................................................................................................................................................................................
Overview

Purpose From the CentreVu Framework window you can access tools to view, 
modify, add, and delete ACD items in the CentreVu CMS database. You 
can use the Navigator to view or modify the properties of objects in your 
Call Center World, including renaming some types of objects. You can use 
the Vector Editor to create new vectors or edit existing ones, and you can 
use VDN Assignment Wizard to assign one or more VDN(s) to a vector.

No matter which tool you use to select an operation, the way in which you 
perform the operation is the same. 

In this section This section includes the following information:

• Starting CentreVu Framework 

• Accessing objects in your Call Center World

• Connecting to a CentreVu CMS Server.



  
Using Framework and Navigator CentreVu Visual Vectors User Guide Release 8

Starting CentreVu Framework 3-7

............................................................................................................................................................................................................................................................
Starting CentreVu Framework 

How to start Centre Vu
Framework

Use the following steps to start the software on Microsoft Corp.Windows 
95/98 or Microsoft Corp.Windows NT 4.0.

...........................................................................................................................................................................

1 Select Start from the taskbar.

...........................................................................................................................................................................

2 Select Programs from the Start menu.

...........................................................................................................................................................................

3 Select the “Lucent CentreVu Visual Vectors 8.0” program group.

...........................................................................................................................................................................

4 Select “CentreVu Visual Vectors 8.0”.

Result:  The software program starts and the Framework window 
opens. Although Visual Vectors is running, you are not yet connected 
to a CMS server.

Result:  CentreVu Framework is Visual Vectors main window. You will 
use the toolbar buttons and pull-down menus to access ACD 
information from a CMS server.

Result:  The following figure illustrates how Framework appears before 
logging into a CMS server.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Accessing objects in your Call Center World 

Procedure To access objects in your Call Center World, complete the following steps:

...........................................................................................................................................................................

1 Select Navigator from the Tools menu or Framework toolbar.

Result:  The Navigator window opens.
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...........................................................................................................................................................................

2 From the File menu in Navigator, or by using the Navigator toolbar, 
select New to add an object, Copy to copy an object to paste later, 
Delete  to remove an object, Rename to change an object’s name, or 
Properties to see an object’s properties.

Result:  If you selected:

• New CMS — the New CMS Server window opens for you to 
specify the parameters of a new server.

• New ScratchPad — the New ScratchPad window opens for you to 
specify the name of a new off-line folder.

• New Vector — the New Vector window opens for you to specify 
the name. This feature can create a new on-line vector that 
contains one Stop step or an empty off-line vector.

• Copy — the selected object is copied. You may paste it into an 
allowable container.

• Delete — the selected object is removed.

• Rename — the Renaming object window appears with the object's 
name highlighted for editing.

• Properties — the Properties window for the selected object opens. 
Some fields may be editable; others are for display only.

...........................................................................................................................................................................

3 Complete entries on the New, Rename, or Properties window (as 
applicable) and select OK.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Connecting to a CentreVu CMS Server

Purpose You can use the Connect menu item or toolbar button to log into a CMS 
server. 

Connection types From CentreVu Framework, you can connect to one or more CMS 
server(s) in either of the following ways. Note that you are limited to one 
instance of a login ID per server.

Existing CMS A valid CMS login ID and password is entered in the Connect to server 
window. Once you select a server and OK, the CMS connection is 
established automatically. If the connection is broken or dropped while you 
are working with tools, you will be prompted to save on-line open vectors 
elsewhere.

New CMS To add a New CMS server to your Call Center World:

1. Access the New CMS window in one of the following ways: 

• In the CentreVu Framework window, select Connect from the 
File menu or the toolbar, and then select New CMS  in the 
Connect to server window.

• In the Navigator window, highlight Call Center World in the left-
hand pane, and then select New CMS from the File or context 
menu.

2. Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. Type a valid Login ID  and 
Password for the server in this window.

3. Select OK.
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Connecting to a server in
your Call Center World

To establish a CMS connection if the server exists in your Call Center 
World, complete the following steps:

...........................................................................................................................................................................

1 Select Connect from the File menu, or click the Connect button on the 
toolbar.

Result:  The Connect to server window opens.

...........................................................................................................................................................................

2 Enter your CentreVu CMS login ID in the Login ID text box.

...........................................................................................................................................................................

3 Tab to or click in the Password text box.

...........................................................................................................................................................................

4 Type your CMS password in the Password text box.

...........................................................................................................................................................................

5 Select a CMS server in you Call Center World from the drop-down list.

...........................................................................................................................................................................

6 Select the Connect button.

Result:  A status message indicates that the software is connecting to 
the CMS server.

E N D  O F  S T E P S....................................................................................................................................................................................
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Connecting to a new
CMS server

To establish a CMS connection if the server is not in your Call Center 
World, complete the following steps:

...........................................................................................................................................................................

1 Select New CMS from the File  menu in the CentreVu Framework 
window.

Result:  The New CMS window opens.

...........................................................................................................................................................................

2 Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. 

...........................................................................................................................................................................

3 Enter your CentreVu CMS login ID in the Login ID text box.

...........................................................................................................................................................................

4 Type your CMS password in the Password text box.

...........................................................................................................................................................................

5 Select OK.

Result:  If the CMS server you entered:

• Exists and can be connected to — a new CMS object will be 
added to your Call Center World and you will be connected to this 
new server.

• Doesn't exist or cannot be connected to — an error message will 
be displayed showing the cause of the failure. 
Go to step 2.

E N D  O F  S T E P S....................................................................................................................................................................................
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Selecting and Running Navigator

............................................................................................................................................................................................................................................................
Overview

Purpose This section introduces you to Navigator window features as they appear 
both before and after connecting to a CentreVu CMS server. Follow the 
instructions to — among other tasks — make menu selections, activate 
toolbar options, read status indicators, use windows, and enter values in 
input fields.

In this section This section includes the following information:

• Basic Navigator window features

• Using Navigator window features.
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............................................................................................................................................................................................................................................................
Basic Navigator Window Features

Overview This section describes the features of the Navigator window.

Navigator window The following figure shows the Navigator window:

System menu box A common Microsoft Corp.Windows convention. The system menu box 
enables you to perform Microsoft Corp.Windows operations, such as 
closing the current window or application. 

Title bar A common Microsoft Corp.Windows convention. The title bar shows the 
name of the application. 

Maximize, minimize and
close buttons

A common Microsoft Corp.Windows convention. The buttons adjust the 
size of the current window or close it. 



  
Using Framework and Navigator CentreVu Visual Vectors User Guide Release 8

Basic Navigator Window Features 3-15

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs.

The default toolbar buttons are as follows: 

Button Function

Up One Level Highlights the “parent” object of the selected object in the 
left pane, displaying the parent object's contents in the 
right pane.

New Creates a new object on the CMS server (or your PC 
ScratchPad).

Delete Removes an object from the CMS server (or your PC 
ScratchPad).

Rename Shows Renaming object window and enters the editing 
mode for the name of the selected object.

Properties Accesses the Properties window for the selected object.

Undo Undoes the last action performed in this Navigator 
session, up to four previous actions.

Redo Redoes the last action that was undone in this Navigator 
session, up to four previous actions.

Cut Removes the selected object and saves it to be pasted 
later.

Copy Makes a copy of the selected object to be pasted later.

Paste Pastes the object that was previously cut or copied.

Details Changes the information displayed in the right pane for 
objects selected in the left pane. Details view is the 
default, showing one row for each object contained in the 
object selected in the left pane. Each row contains 
columns for the object's Name, Number, Type, and your 
read/write Permissions for it.

List Changes the information displayed in the right pane for 
objects selected in the left pane. List view shows one 
named icon for each object contained in the object that is 
selected in the left pane.

Help Contents Opens the Help Topics window, and displays the table of 
contents. 
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Status messages Visual Vectors may display any of the following messages.

Menu bar The menu bar identifies the four menus that are available after you log into 
a CMS server: File, Edit, View, and Help.

This message 
…

Displays when …

Starting tool... A Visual Vectors window is opening. Framework is 
locked during this time. 

Looking for items 
to Connect...

Framework is searching your Call Center World for CMS 
servers.
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File menu window The following figure shows the file menu in the Navigator window:

File menu items  The File menu has the following items.

New  Creates a new object on the CMS server (or your PC ScratchPad).

Delete  Removes an object from the CMS server (or your PC 
ScratchPad).

Rename  Shows Renaming object window and enters the editing mode for 
the name of the selected object.

Properties  Accesses the Properties window for the selected object.

Close  Closes the Navigator tool’s window.
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Edit menu window The following figure shows the edit menu in the Navigator window:

Edit menu items The Edit menu has the following items.

Undo  Undoes the last action performed in this Navigator session, up to 
four previous actions.

Redo  Redoes the last action that was undone in this Navigator session, 
up to four previous actions.

Cut  Removes the selected object and saves it to be pasted later.

Copy  Makes a copy of the selected object to be pasted later.

Paste  Pastes an object that was previously cut or copied.
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View menu window The following figure show the view menu in the Navigator window:

View menu items The View menu has the following items.

Up One Level  Highlights the “parent” object of the selected object in the 
left pane, displaying the parent object's contents in the right pane.

Details  Changes the information displayed in the right pane for objects 
selected in the left pane. Details view is the default, showing one row for 
each object contained in the object selected in the left pane. Each row 
contains columns for the object's Name, its Type, and your read/write 
Permissions for it.

List  Changes the information displayed in the right pane for objects 
selected in the left pane. List view shows one named icon for each object 
contained in the object selected in the left pane.

Refresh  Refreshes and redraws both panes of the Navigator windows.
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Help menu window The following figure shows the help menu in the Navigator window:

Help menu items Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the following items. 

Help Contents  Opens the Help Topics window, and displays the table of 
contents. 

About…  Opens the About… window, which shows the software version 
number. 
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............................................................................................................................................................................................................................................................
Using Navigator Window Features

Overview This section describes how to use three features that are common to 
Navigator menus and the Help system.

Navigator menus To select a Navigator menu item, choose any of the following methods: 

• Click on the item

• Use the arrow keys to highlight the item and then press Enter 

• Press the Alt key and press the underlined letter in the menu or item 
you want to select

• Hold down the Ctrl key and press the accelerator key assigned to the 
action. For example, use Ctrl+C to copy. 

Help system Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the Navigator help 
options described in Basic Navigator Window Features (3-14).
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Navigating Your Call Center World

............................................................................................................................................................................................................................................................
Overview

Purpose Use Navigator to browse the following ACD entities:

• Any entities of the ACD, including announcements, splits/skills, trunk 
groups, VDNs, and vectors

• VDN administration, including the vector and skill preference(s) 
assigned to one or more VDN(s)

In this section The section includes the following information:

• Exploring an object

• Using property windows

• Completing input fields.



  
Using Framework and Navigator CentreVu Visual Vectors User Guide Release 8

Exploring an Object 3-23

............................................................................................................................................................................................................................................................
Exploring an Object

Actions and Properties The objects visible in Navigator windows have sets of:

• Actions that may be performed on them (see Call Center World 
Objects (2-25))

• Properties, some of which may be modified (see Using Property 
Windows (3-24)).

How to explore an object ...............................................................................................................................................................................

1 Browse your Call Center World and find the object you want.

• Click the + icon next to an object (for example, a CMS) to expand the 
display and show objects contained by that object (for example, 
ACDs).

• If needed to reduce clutter, click the – icon to the left of an object to 
collapse the display and hide the objects within that object.

...........................................................................................................................................................................

2 A double-click on an object performs the default function. For example, 
a double-click on a container allows you to explore it. However, a 
double-click on a vector takes you directly to editing the selected vector.

Alternatively, you can right-click on the object and select an item from its 
context menu.

...........................................................................................................................................................................

3  An object's context menu displays when you highlight the object and 
right-click on it. Allowable actions are displayed in the menu.

E N D  O F  S T E P S....................................................................................................................................................................................

For more information To see what actions can be performed on each possible object in your Call 
Center World, refer to Call Center World Objects (2-25) .
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............................................................................................................................................................................................................................................................
Using Property Windows

How to use property
windows

If you need to know... Then refer to...

What properties an object has Call Center World Object 
Properties (2-31)

How to edit properties Completing Input Fields (3-25)
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............................................................................................................................................................................................................................................................
Completing Input Fields 

Options You can complete an input field by doing one of the following:

• Enter the requested information in the text box. 

• Select the information from a drop-down list of valid entries. 

• Check a box for the input field. 
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4 Using the Vector Editor

............................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use the Vector Editor.

It is divided into the following sections:

• Vector Editor Overview

• Using the Vector Editor

• Printing Vectors.

See the overview to each section for a preview of the section's contents.
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Vector Editor Overview

............................................................................................................................................................................................................................................................
Overview

Purpose To run the Vector Editor, you need to start CentreVu Framework and then 
select the Vector Editor from the Tools menu or the CentreVu Framework 
toolbar. The Vector Editor also starts when you open a vector through the 
Navigator.

In this section Starting to use visual vectors introduces a number of ACD and CentreVu 
CMS terms, including:

• Terms you need to know

• Visual Vectors' features

• Starting the Vector Editor

• Accessing vectors in your Call Center World

• Closing windows

• Disconnecting and exiting the software.
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............................................................................................................................................................................................................................................................
Terms You Need to Know

Terms Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys   Keys that provide shortcuts to actions available on the 
menu.

Automatic Call  Distribution (ACD)   A switch feature using software that 
channels high-volume incoming and  outgoing call traffic to agent groups 
(splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Vectoring  A switch feature that provides a highly flexible method for 
processing ACD calls using VDNs and vectors as processing points 
between trunk groups and splits. Call vectoring permits treatment of calls 
that is independent of splits.

Similar to a computer program, a call vector is a set of instructions that 
control the routing of incoming calls based on conditions that occur in a 
call center environment. Examples of call vector conditions include time of 
day and the number of calls in queue.

CentreVu Visual Vectors window   The window in which you are 
currently working (usually indicated by a highlighted title bar). Visual 
Vectors has a Framework window and windows for each of the tools, 
including Navigator, Vector Editor, and VDN Assignment.

Container   An object in your Call Center World that logically contains 
other entities or objects. For example, each CMS object in your Call 
Center World can contain as many as 8 ACD objects, each of which 
contains entity folders (for announcements, split or skill objects, trunk 
groups, VDNs, and vectors).

Context menu   A menu with specific actions for an entity or item.

Expert Agent Selection (EAS)  Expert Agent Selection (EAS) is an 
optional switch feature that builds on the power of the Call Vectoring and 
ACD features of the switch to match the skills required to handle a 
particular call to an agent who has at least one of the skills that a caller 
requires. The ACD queuing and the Queue and Check  vector commands 
are used to route a call to an agent with the appropriate skill to handle that 
call. With EAS, call distribution is based on skill.

CentreVu CMS collects data on skills in the same manner as it collects 
data on splits.
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CentreVu CMS also reports VDN data by VDN skill preference, so that 
customers can assess the call center performance relative to calls 
requiring particular skills. CMS reports how many calls were handled, how 
long these calls waited for service, and the average talk time for calls 
queued to a particular skill preference in a particular VDN.

Folder   An object in the Navigator tool that contains entities 
(announcements, splits/skills, trunk groups, VDNs, and vectors). Folders 
are used to visually group all entities of a specific type for an ACD.

Input field   An area in a window into which you enter one or more valid 
values. Valid values may be integers, for example, or names assigned in 
the CentreVu CMS Dictionary.

Menu bar   A menu bar is under the title bar of most windows. The menu 
bar shows the menu names available for that particular window (for 
example, File and Help). You select an item from one of these drop-down 
menus.

Name (synonym) fields    Fields in which you may enter a name 
(synonym) that has been assigned in the CMS Dictionary (for example, the 
name of a vector).

Object   Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administrable entity itself (VDN).

Skill  Attributes of ACD agents with the EAS feature enabled. In 
relationship to your call center, think of skill as a specific customer need/
requirement or perhaps a business need of your call center. You will be 
defining your skills based on the needs of your customers and your call 
center.

ScratchPad  The Default ScratchPad name is a container area on your 
PC designed to save vectors off-line. ScratchPad is available any time. 
You can create a hierarchy of sub-folders under the default folder by 
selecting New ScratchPad from Navigator’s File menu.

Status bar   A status bar is across the bottom of some windows. The 
status bar shows information about the current action in that window.

Switch  A private switching system providing voice-only or voice and data 
communications services (including access to public and private networks) 
for a group of terminals within a customer’s premises.
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Title bar   A title bar is across the top of most windows. The title bar shows 
the name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar   A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tools menu   A drop-down menu on the CentreVu Framework menu bar 
that gives you access to the Navigator, Vector Editor, and VDN 
Assignment tools.

Tooltips   Tooltips are available in most windows by placing the mouse 
cursor over an item for two seconds. Tooltips usually describe the actions 
performed by selecting an icon. Tooltips can be disabled on the 
Preferences window accessed from the File menu of CentreVu 
Framework.

VDN  See Vector Directory Number.

VDN Assignment Wizard   A series of dialogue boxes that displays after 
you select it from the Tools menu or toolbar. It consists of several steps 
presented in the dialogue boxes; for example, one filters and selects the 
VDNs you wish to assign, and another performs the assignment(s).

VDN Calls-Counted  Also known as counted-calls to VDN and active 
VDN calls. A Call Vectoring capability available with G3V4 or later 
switches. Counted-calls to VDN is a parameter of the go to step and go 
to vector commands that provides conditional branching (to a different 
step in the same vector or to a different vector) based on the number of 
incoming trunk calls a VDN is currently processing.

VDN Skill Preference  Up to three skill(s) can be assigned to a VDN. 
Calls use VDN skills for routing based on your preference (as you 
administer it in the vector). VDN skill preferences are referred to in the 
vector as “1st,” “2nd,” or “3rd.”

Vector  A list of steps that process calls in a user-defined manner. The 
steps in a vector can send calls to splits, play announcements and music, 
disconnect calls, give calls a busy signal, or route calls to other 
destinations. Calls enter vector processing via VDNs, which may have 
received calls from assigned trunk groups, from other vectors, or from 
extensions connected to the switch.

Vector Command    A vector step that describes the action to be 
executed for a call (for  example, Queue, check, disconnect).
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Vector Directory Number (VDN)  An extension number that enables calls 
to connect to a vector for processing. A VDN is not assigned an equipment 
location. It is assigned to a vector. A VDN can connect calls to a vector 
when the calls arrive over an assigned automatic-in trunk group or when 
calls arrive over a dial-repeating (DID) trunk group and the final digits 
match the VDN. The VDN by itself may be dialed to access the vector from 
any extension connected to the switch.

Vector Editor   This software tool, accessed from CentreVu Framework, 
allows you to create and edit vectors visually, by dragging and dropping 
icons representing commands from a palette and arranging them into 
vector steps in a work area. You can attach comments, change layout, and 
save and print the vectors.

Vector Step  One processing step in a vector. A vector step consists of a 
command and one or more conditions or parameters. These conditions or 
parameters are found on a step’s Properties window in Visual Vectors 
client software.

Vector Step Condition  A condition accompanying a vector command 
that defines the circumstances in which the command will be applied to a 
call. These conditions are found on a step’s Properties window in Visual 
Vectors client software.
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............................................................................................................................................................................................................................................................
Visual Vectors’ Features

Software functions Visual Vectors’ Vector Editor has two main functions:

• To allow visual creation and editing of vectors by an easy, drag-and-
drop method

• To annotate (by attaching comments) and to print representations of 
vectors.

Note that the Navigator tool supplies a read-only plain text view of vectors 
for users familiar with accessing vectors via a terminal.
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............................................................................................................................................................................................................................................................
Starting the Vector Editor

How to start the Vector
Editor

Use the steps below to start Vector Editor for Microsoft Corp. Windows 95/
98 or Microsoft Corp. Windows NT 4.0.

...........................................................................................................................................................................

1 Select Start from the taskbar.

...........................................................................................................................................................................

2 Select Programs from the Start menu.

...........................................................................................................................................................................

3 Select the Lucent CentreVu Visual Vectors 8.0 program group.

...........................................................................................................................................................................

4 Select CentreVu Visual Vectors 8.0 from the menu.

...........................................................................................................................................................................

5 Select Vector Editor from the Tools menu or toolbar in the CentreVu 
Framework window and the type of vector you want. You can also 
double-click on a vector in Navigator.

Result:  The CentreVu Framework and Vector Editor tool windows are 
displayed. Although Framework is now running, you are not connected 
to a CentreVu CMS server.

Result:  The following figure illustrates how the main window appears 
before connecting to a CMS server.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Accessing Vectors in your Call Center World 

How to access vectors To access vectors in your Call Center World, complete the following steps:

...........................................................................................................................................................................

1 Select Navigator from the Tools menu or CentreVu Framework toolbar.

Result:  The Navigator window opens.
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...........................................................................................................................................................................

2 Select an object that can contain a vector, such as the scratchpad or an 
ACD’s Vector Folder in the Navigator window.

Result:  The objects contained in the folder appear in the right-hand 
pane of the Navigator window.
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...........................................................................................................................................................................

3 From the File menu in Navigator, or on the Navigator toolbar, select new 
if you are working with on-line vectors or R6 Vector (EAS), R6 Vector 
(EAS Non-Prompting), R6 Vector (Non-EAS,), R6  Vector (Non-EAS 
Non-Prompting), R8 Vector (EAS), R8 Vector (EAS Non-Prompting), R8 
Vector (Non-EAS,), or R8  Vector (Non-EAS Non-Prompting) if you are 
working with off-line vectors. These choices allow you to see a vector’s 
properties or to add, move, delete or rename a vector.

Result:  If you selected: 

• A new on-line vector the window opens for you to specify the 
Name and Id. If you selected an off-line vector, the window opens 
for you to specify only the Name.

• Rename — the Renaming Vector window opens for you to edit the 
vector's name.

• Delete — the selected object is replaced with a blank object.

• Properties — the Properties window for the selected object opens.

...........................................................................................................................................................................

4 Select OK.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Closing windows

How to close windows To close an open tool such as the Vector Editor window, select Close from 
the File menu, or press Alt+ F4. If you have unsaved changes to the 
current vector, you will be prompted to save them.

To close all windows, select the Close All item on the Window menu from 
the CentreVu Framework window.
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............................................................................................................................................................................................................................................................
Disconnecting and exiting the software

How to disconnect and
exit the software

To exit the software, select Exit from the File menu in the CentreVu 
Framework window.

The software automatically disconnects from any CMS servers to which 
you are connected and then closes CentreVu Framework window.

 A warning message appears if you have open tool windows. If you restart 
CentreVu Framework after closing it while leaving tools windows open, it 
will attempt to restore the open windows and server connections 
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Using the Vector Editor

............................................................................................................................................................................................................................................................
Overview

Purpose This section introduces you to the Vector Editor window features as they 
appear both before and after logging into CentreVu CMS. Follow the 
instructions to — among other tasks — create new vectors and edit 
existing ones and then save them in your Call Center World, use 
Properties windows, and enter values in input fields.

In this section This section includes the following information:

• Basic Vector Editor window features

• Using Vector Editor menus and palettes

• Opening Vectors

• Saving Vectors

• Using step property windows

• Completing input fields

• Vector Scenarios

• Printing vectors.
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............................................................................................................................................................................................................................................................
Basic Vector Editor Window Features

Overview This section describes the features of the Vector Editor window.

Vector Editor window The following figure shows the Vector Editor window:
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System menu box A common convention. The system menu box enables you to perform 
Microsoft Corp. Windows operations, such as closing the current window 
or application. 

Title bar A common convention. The title bar shows the name of the application.

Minimize, maximize and
close buttons

A common convention. The buttons in the upper right-hand corner adjust 
the size of the current window, or close it. 

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs.

The default Vector Editor toolbar buttons are as follows: 

Button Function

New Creates a new vector in memory.

Open... Displays the Select the Vector to Open window, allowing 
you to browse your Call Center World to find the vector you 
want to work with.

Save Saves your vector to the CMS Server (or PC ScratchPad) 
from which you opened it.

Print... Displays the standard Windows Print window.

Cut Removes whatever you select and saves it to be pasted later.

Copy Makes a copy of whatever you select to be pasted later.

Paste Pastes the selection that was previously cut or copied.

Delete Removes whatever you select from the vector.

Undo Undoes the last action performed in this Vector Editor 
session.

Redo Redoes the last action that was undone in this Vector Editor 
session.

Zoom In Magnifies the vector display each time it is selected.

Zoom Out Decreases the magnification of the vector display each time 
it is selected.

Help Contents Opens the Help Topics window, and displays the table of 
contents.
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Status indicators These indicators on the status bar provide information about the current 
vector.

Menu bar A common Microsoft Corp. Windows convention. The menu bar lists the 
available drop-down menus. The following information identifies these 
menus: File, Edit, View, Insert, and Help.

This 
indicator …

Displays …

Vector 
Location

Shows New Vector or a full path to an existing vector in 
your Call Center World (for example, /Call Center 
World/CMS20/ACD8/Vector Folder/Visual 
Vector).

Current Visual 
Steps 

A count of the number of palette icons in the current visual 
vector. The icon for the initial Start icon is not counted.

Current Stored 
Steps 

A count of the number of vector steps the current vector will 
occupy when stored on an ACD. The limit is 32 steps. At 
step 29, the line stating the number steps turn yellow. At step 
33, the line turns red.
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File menu window The following figure shows the file menu window:

File menu items  The File menu has the following items:

New  Creates a new R6 Vector (EAS),   R6 Vector (EAS Non-Prompting),  
R6 Vector (Non-EAS),  R6 Vector (Non-EAS, Non-Prompting), R8 Vector 
(EAS),   R8 Vector (EAS Non-Prompting),  R8 Vector (Non-EAS), or  R8 
Vector (Non-EAS, Non-Prompting) in memory.

Open...  Displays the Select the Vector to Open window, allowing you to 
browse your Call Center World to find the vector you want to work with.

Save  Saves your vector in memory.

Save As...  Displays the Save Vector As window.

Print...  Displays the standard Windows Print window.

Properties  Accesses the Properties window for the current vector.

Close  Closes the Vector Editor tool’s window.
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Edit menu window The following figure shows the edit menu window:
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Edit menu items The Edit menu has the following items: 

Undo  Undoes the last action performed in this Vector Editor session. 
There are no limits to the number of actions you can undo in Vector Editor.

Redo  Redoes the last action that was undone in this Vector Editor 
session. There are no limits to the number of actions you can redo in 
Vector Editor.

Cut  Removes whatever you selected and saves it to be pasted later.

Copy  Makes a copy of your selection to be pasted later.

Paste  Pastes the selection that was previously cut or copied.

Delete  Removes whatever you selected from the vector.
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View menu window The following figure shows the view menu window:
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View menu items The View menu has the following items: 

Toolbar  Toggles showing the Vector Editor toolbar.

View Comments  Toggles showing the comments for the vector steps.

View Labels  Toggles showing the labels for the vector steps.

Layout...  Displays a window allowing you to change how vectors are laid 
out (oriented).

Reset Zoom  Resets the zoom magnification to the default of 100 percent.

Zoom In  Magnifies the vector display each time it is selected.

Zoom Out  Decreases the magnification of the vector display each time it 
is selected.

Insert menu window The following figure shows the insert menu window:
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Insert menu item The Insert menu has the following item.

Comments  Allows you to type free-floating comments and attach them to 
a visual vector. If you use a tool other than the Vector Editor to edit vectors, 
then your step comments will be detached from the vector steps and you 
will have to re-attach them.

Help menu window The following figure shows the help menu window:

Help menu items Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the following:

Help Contents  Opens the Help Topics window, and displays the table of 
contents. 

About…  Opens the About… window, which shows the software version 
number. 
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............................................................................................................................................................................................................................................................
Using Vector Editor Menus and Palettes

Vector Editor Menus To select a Vector Editor menu item, choose any of the following methods: 

• Click on the item

• Use the arrow keys to highlight the item and then press Enter

• Hold down the Alt key and press the underlined letter in the menu 
item you want to select

• Hold down the Ctrl key and press the key assigned to the operation. 
For example, use Ctrl+C to copy. 

Vector Step Palettes Vector Steps are grouped in the following five palettes on the left-hand 
side of the Vector Editor window. Please note that not all the steps are 
available for every type of vector. For example, the collect step is not 
available for non-prompting vectors.

• Input/Output

– Announcement

– Timed Announcement

– Music

– Ringback

– Silence

– Reply

– Consider

– Collect

– Converse

• End

– Busy

– Stop

– Disconnect

• Test

– Caller Info

– Center Info

– Queue Activity

– Agent Activity

– Time of Day
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• Queue

– Queue Activity

– Center Info

– Agent Activity

– Queue Unconditional

• Routing

– Route To Number

– Route To Digits

– Adjunct Route

– Messaging Skill

– Goto Vector.

Help system Press the F1 key or select the Help button to display context-sensitive help. 
Select Help from the menu bar to choose from the help options described in 
Basic Vector Editor Window Features (4-15).
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............................................................................................................................................................................................................................................................
Opening Vectors 

Overview Regardless of which window you use to select vectors, the actions you 
may perform are the same.

Vector Editor window The following figure shows the file menu from the Vector Editor window:
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Access procedures To open a vector from the Vector Editor window, do the following:

...........................................................................................................................................................................

1 Select the Open... menu item from the File menu.

Result:  A Select the Vector to open window displays.

...........................................................................................................................................................................

2 Browse your Call Center World and find the vector you want.

• Click the + icon next to a container (for example, a Vector Folder) to 
show objects contained within it (for example, vectors).

• If needed to reduce clutter, click the – icon to the left of a container to 
collapse the display and hide the objects within it.
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...........................................................................................................................................................................

3 Highlight the name of the vector you would like to access.

...........................................................................................................................................................................

4 Select the Open button.

Result:  A graphical representation of the selected vector appears in 
the Vector Editor window.

E N D  O F  S T E P S....................................................................................................................................................................................

In Navigator

Alternatively, you can double-click the vector in the Navigator tool, or right-
click the vector and select Edit from the context menu.
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Features of the Select
the Vector to open

window

The Select the Vector to open window has the following features.

Open from

Use this area to browse your Call Center World for the object you want.

Object Name

The name of the object you have highlighted in the Open from area. 

Of Type

The type of object that is currently selected. 

Open and Cancel buttons 

The Open and Cancel buttons you see on this window performs standard 
Microsoft Corp. Windows actions.

• Open accepts the current input and displays the next window. 

• Cancel ignores the current input and returns you to the previous 
window. 



  
Using the Vector Editor CentreVu Visual Vectors User Guide Release 8

Saving Vectors 4-30

............................................................................................................................................................................................................................................................
Saving Vectors 

Overview Regardless of which window you use to select objects, the actions that you 
may perform are the same.

Saving procedures To save a vector from the Vector Editor window, do the following:

...........................................................................................................................................................................

1 Select the Save As... menu item from the File menu.

Result:  A Save Vector As window displays.



  
Using the Vector Editor CentreVu Visual Vectors User Guide Release 8

Saving Vectors 4-31

...........................................................................................................................................................................

2 Browse your Call Center World and find the container in which you want 
to save the current vector.

• Click the + icon next to a container (for example, a Vector Folder) to 
show objects contained within it (for example, vectors).

• If needed to reduce clutter, click the – icon to the left of a container to 
collapse the display and hide the objects within it.

...........................................................................................................................................................................

3 Highlight the name of the container (ScratchPad or Vector Folder) you 
chose.

...........................................................................................................................................................................

4 If you want to give the vector a name different from the default name; 
type your preferred name in the Name field.

...........................................................................................................................................................................

5 Select the Save button.

Result:  A graphical representation of the selected vector is saved to 
the scratchpad, or the visual vector is converted and stored on the 
ACD containing the Vector Folder.

E N D  O F  S T E P S....................................................................................................................................................................................

In Navigator

Alternatively, you can drag and drop one or more vectors in the Navigator 
tool.
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Features of the Save
Vector As window

The Save Vector As window has the following features.

Save In

Use this area to browse your Call Center World for the container you want.

Name

The name of the vector

Of Type

This drop-down list box shows the type of object that is currently selected.

Save and Cancel buttons 

The Save and Cancel buttons you see on this window performs standard 
Microsoft Corp. Windows actions.

• Save accepts the current input and displays the next window. 

• Cancel ignores the current input and returns you to the previous 
window. 
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............................................................................................................................................................................................................................................................
Using Step Property Windows

Overview Once you have selected properties from the context menu for an object, 
an input window displays. The information required in the input window 
depends on the object.

This section describes all possible properties. However, not all features 
automatically show. Which properties are shown, which menu items are 
available, and which toolbar buttons function can vary from user to user.

The tables in this section state that you can have as many as 999 Skill Ids. 
This is true for CentreVu CMS R3V8 vectors. However, CentreVu CMS 
R3V6 vectors can still only have a maximum of 600 vectors.

The following are described:

• Basic features of fields on property windows (4-34)

• Properties of the Announcement (Input/Output) step (4-34)

• Properties of the Timed Announcement (Input/Output) step (4-34)

• Properties of the Music (Input/Output) step (4-34)

• Properties of the Ringback (Input/Output) step (4-35)

• Properties of the Silence (Input/Output) step (4-35)

• Properties of the Reply (Input/Output) step (4-35)

• Properties of the Consider (Input/Output) step (4-35)

• Properties of the Collect (Input/Output) step (4-36)

• Properties of the Converse (Input/Output) step (4-36)

• Properties of the Busy (End) step (4-36)

• Properties of the Stop (End) step (4-36)

• Properties of the Disconnect (End) step (4-37)

• Properties of the Caller Info (Test) step (4-37)

• Properties of the Center Info (Test) step (4-37)

• Properties of the Queue Activity (Test) step (4-38)

• Properties of the Agent Activity (Test) step (4-38)

• Properties of the Time Of Day (Test) step (4-39)

• Properties of the Queue Activity (Queue) step (4-39)

• Properties of the Center Info (Queue) step (4-40)

• Properties of the Agent Activity (Queue) step (4-40)

• Properties of the Queue Unconditional (Queue) step (4-41)

• Properties of the Route To Number (Routing) step (4-41)

• Properties of the Route To Digits (Routing) step (4-41)

• Properties of the Adjunct Route (Routing) step (4-41)

• Properties of the Messaging Skill (Routing) step (4-42)

• Properties of the Goto Vector (Routing) step (4-42)
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Basic features of fields
on property windows

Use the Property window features to enter or edit existing field values, as 
follows:

Announcement (Input/
Output) step

The following describes the Announcement (Input/Output) step:

Timed Announcement
(Input/Output) step

The following describes the Timed Announcement (Input/Output) step:

Music (Input/Output)
step

The following describes the Music (Input/Output) step:

Feature Action

Text boxes Type in any characters from the keyboard for this field.

Drop-down 
lists

View and select from a list of the valid values available for 
this input field.

Numeric 
fields

Type in numbers (depending on ECS/switch type and 
software version) as the valid entries for this input field.

Check Boxes Select the check box to toggle it on for yes or off for no.

Properties Description

Announcement Select a valid announcement for the ACD on which the 
step will be saved, or select Extension.

Extension Enter a 1-5 digit extension number. Default is 0. Disabled 
if Announcement is not Extension.

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Announcement Select a valid announcement for the ACD on which the 
step will be saved, or select Extension.

Extension Enter a 1-5 digit extension number. Default is 0. Disabled 
if Announcement is not Extension.

Treatment Select music, silence, ringback, or continue. Default is 
continue.

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Comment A comment associated with this step.
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Ringback (Input/Output)
step

The following describes the Ringback (Input/Output) step:

Silence (Input/Output)
step

The following describes the Silence (Input/Output) step:

Reply (Input/Output) step The following describes the Reply (Input/Output) step:

Consider (Input/Output)
step

The following describes the Consider (Input/Output) step:

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

I-Silent Check to enable.

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.

Properties Description

Measure Split/Skill is the default value. Or select location from 
drop-down list, if applicable.

Split/Skill Select a split or skill (or First, Second, Third, or Id) from 
drop-down list. Disabled if Measure is Location.

Skill Id Enter numeric value 1-999 (default=1). Disabled if 
Measure is Location or if Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list. Disabled if Measure is Location.

Location Enter numeric value 1-255 (default=1). Disabled if 
Measure is Split/Skill.

Adjustment Enter numeric value 0-100 (default=0).

Comment A comment associated with this step.
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Collect (Input/Output)
step

The following describes the Collect (Input/Output) step:

Converse (Input/Output)
step

The following describes the Converse (Input/Output) step:

Busy (End) step The following describes the Busy (End) step:

Stop (End) step The following describes the Stop (End) step:

Properties Description

Source Digits is the default value. Or select CED or CDPD from 
drop-down list, if applicable.

Number of digits Enter numeric value 1-16 (default=1). Disabled if Source 
is not digits.

Comment A comment associated with this step.

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, or Id) from 
drop-down list. Disabled if Measure is Location.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list. Disabled if Measure is Location.

Passing None is the default value. Or select vdn, ani, digits, qpos, 
wait, or data from drop-down list.

Data Enter up to a 6-digit number, if applicable (default is 
blank). Enabled if first Passing is Data.

Passing None is the default value. Or select vdn, ani, digits, qpos, 
wait, or data from drop-down list. If the first Passing 
property value is none, then the only valid value for this 
second Passing property is none.

Data Enter up to a 6-digit number, if applicable (default is 
blank). Enabled if second Passing is Data.

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.
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Disconnect (End) step The following describes the Disconnect (End) step:

Caller Info (Test) step The following describes the Caller Info (Test) step:

Center Info (Test) step The following describes the Center Info (Test) step:

Properties Description

Comment A comment associated with this step.

Properties Description

Measure ANI is the default value. Or select digits or ii-digits from 
drop-down list, if applicable.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, >=, 
in , or not in, from drop-down list.

Threshold Zero (0) is the default value. Or enter a numeric value (1-
16 characters if ani or digits, 00-99 if ii-digits). Disabled 
if Comparator is in or not in.

Table One (1) is the default value. Or enter a numeric value (1-
100). Disabled if Comparator is not in or not in.

Comment A comment associated with this step.

Properties Description

Measure Counted-calls to VDN is the default value. Or select 
rolling-asa, expected-wait from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, Best, Call, 
or Id) from drop-down list. Disabled if Measure is not 
expected wait.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list. Disabled if Measure is not expected 
wait, or if Split/Skill is Best or Call.

VDN Select a VDN (or extension, active, or latest) from drop-
down list. Disabled if Measure is expected wait.

Extension Enter a 1-5 digit extension number. Disabled if VDN is 
not an extension.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, >=, 
from drop-down list.
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Queue Activity (Test)
step

The following describes the Queue Activity (Test) step:

Agent Activity (Test) step The following describes the Agent Activity (Test) step:

Threshold One (1) is the default value. Or enter a numeric value that 
depends on Measure and your ECS/switch software 
version.

Comment A comment associated with this step.

Properties Description

Properties Description

Measure Rolling-asa is the default value. Or select calls-queued, 
interflow-qpos, oldest-call-wait, or wait-improved from 
drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, Id, or Best) 
from drop-down list. Disabled if Measure is interflow-
qpos.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list.  Disabled if Measure is interflow-
qpos or Split/Skill is Best.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, >=, 
from drop-down list.

Threshold One (1) is the default value. Or enter a numeric value that 
depends on Measure and your ECS/switch software 
version.

Comment A comment associated with this step.

Properties Description

Measure Available-agent is the default value. Or select staffed-
agents from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, or Id) from 
drop-down list.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, >=, 
from drop-down list.
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Time Of Day (Test) step The following describes the Time Of Day (Test) step:

Queue Activity (Queue)
step

The following describes the Queue Activity (Queue) step:

Threshold Zero (0) is the default value. Or enter a numeric value that 
depends on Comparator and your ECS/switch software 
version.

Comment A comment associated with this step.

Properties Description

Properties Description

Start Day All is the default. Or select beginning day from the drop-
down list. All if Finish Day is All.

Start Time Current time is default. Or enter beginning time of day in 
24-hour format.

Finish Day All is the default. Or select ending day from the drop-
down list. All if Start Day is All.

Finish Time Current time is default. Or enter ending time of day in 24-
hour format.

Comment A comment associated with this step.

Properties Description

Measure Rolling-asa is the default value. Or select calls-queued, 
oldest-call-wait, or wait-improved from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, Id, or Best) 
from drop-down list. Disabled if Measure is interflow-
qpos.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list.  Disabled if Split/Skill is Best.

Comparator Auto-selected default value. Read-only field.

Threshold One (1) is the default value. Or enter a numeric value that 
depends on Measure and your ECS/switch software 
version.

Comment A comment associated with this step.
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Center Info (Queue) step The following describes the Center Info (Queue) step:

Agent Activity (Queue)
step

The following describes the Agent Activity (Queue) step:

Properties Description

Measure Expected-wait is the available value.

Split/Skill Select a split or skill (or First, Second, Third, Best, or Id) 
from drop-down list.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list. Disabled if Split/Skill is Best.

Comparator Auto-selected default value. Read-only field.

Threshold One (1) is the default value. Or enter a numeric value that 
depends on Measure and your ECS/switch software 
version.

Comment A comment associated with this step.

Properties Description

Measure Available-agents is the default value. Or select staffed-
agents from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, or Id) from 
drop-down list.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority Low is the default value. Or select medium, high, or top 
from drop-down list.

Comparator Auto-selected default value. Read-only field.

Threshold Zero (0) is the default value. Or enter a numeric value that 
depends on Comparator and your ECS/switch software 
version.

Comment A comment associated with this step.
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Queue Unconditional
(Queue) step

The following describes the Queue Unconditional (Queue) step:

Route To Number
(Routing) step

The following describes the Route To Number (Routing) step:

Route To Digits
(Routing) step

The following describes the Route To Digits (Routing) step:

Adjunct Route (Routing)
step

The following describes the Adjunct Route (Routing) step:

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, Id, or Best) 
from drop-down list.

Skill Id Enter numeric value 1-999 (default=1). Disabled if Split/
Skill is not Id.

Priority High is the default value. Or select low, medium, or top 
from drop-down list.  Disabled if Split/Skill is Best.

Comment A comment associated with this step.

Properties Description

Number Zero (0) is the default. Or enter a 1-16 digit number.

Coverage No is the default value. Or select yes from the drop-down 
list.

Comment A comment associated with this step.

Properties Description

Coverage No is the default value. Or select yes from the drop-down 
list.

Comment A comment associated with this step.

Properties Description

Extension Enter a 1-5 digit extension number. Default is 0.

Comment A comment associated with this step.
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Messaging Skill
(Routing) step

The following describes the Messaging Skill (Routing) step:

Goto Vector (Routing)
step

The following describes the Goto Vector (Routing) step:

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, or Id) from 
drop-down list.

Skill Id Enter numeric value 1-999. Disabled if Split/Skill is not 
Id.

Extension Extension is the default. Or select active or latest.

Number Zero (0) is the default. Or enter a 1-5 digit extension 
number. Disabled if Extension is active or latest.

Comment A comment associated with this step.

Properties Description

Vector Select a valid vector for the ACD on which the step will 
be saved, or select Id.

Vector Id Enter the numeric Id of a valid vector. Disabled if Vector 
is not Id.

Comment A comment associated with this step.
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............................................................................................................................................................................................................................................................
Completing Input Fields 

Options You can complete an input field by doing one of the following:

• Enter the requested information in the text box. 

• Select the information from a drop-down list of valid entries.

• Check a box for the input field. 
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............................................................................................................................................................................................................................................................
Vector Scenarios

Overview There are many tasks related to call vectoring that Visual Vectors software 
helps you perform.

Common scenarios may include:

• Creating a New Goto Vector (4-44)

• Moving/Copying or Saving Vectors to ACDs of Differing Types (4-53).

Creating a New Goto
Vector ...............................................................................................................................................................................

1 Start CentreVu Visual Vectors.

Result:  The CentreVu Framework window appears.

...........................................................................................................................................................................

2 In the CentreVu Framework window, select Vector (EAS) from the sub-
menu for Vector Editor on the Tools menu or toolbar.

Result:  The Vector Editor window appears for a New Vector with an 
empty (grey) box for the first step.

...........................................................................................................................................................................

3 To start your new vector, you want processing to branch to a different 
vector for nighttime callers only. First, you must test for the time of day. 
On the left-hand side of the Vector Editor window, select the Test 
palette.

Result:  The available icons for the Test palette are displayed.

...........................................................................................................................................................................

4 Using the tooltips (if enabled), locate and select the Time Of Day icon, 
then drag the icon and drop it on the empty step box in the workspace 
area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

5 Select Properties  from the context (right-click) menu for the Time Of 
Day icon, or double-click the icon.

Result:  The Properties of Time Of Day window appears with default 
values.
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...........................................................................................................................................................................

6 Select the Start Time: fields and enter 23: 00 and then select the Finish 
Time: fields and enter 5: 00

Result:  Leading zeroes are discarded from numeric entries.

...........................................................................................................................................................................

7 Optionally, you may type a comment for this test in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this test icon 
changes to TOD All 23:00 to All 05:00.

...........................................................................................................................................................................

8 Two arrows to empty step boxes now appear in the workspace. The 
solid arrow points to the next step if the test is true; the broken or dotted 
arrow points to the next step if the test is false. To make a Goto Vector 
step, select the Routing palette.

Result:  The available step icons change to display icons for Routing.

...........................................................................................................................................................................

9 Locate and select the icon in the palette for the Goto Vector step, then 
drag the icon and drop it on the empty step box for TRUE in the 
workspace area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

10 Select Properties  from the context (right-click) menu for the Goto 
Vector step icon, or double-click the icon.

Result:  The Properties of Goto Vector window appears with the 
required field outlined in red.

...........................................................................................................................................................................

11 Select the Vector ID: field and enter 2.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

...........................................................................................................................................................................

12 Optionally, you may type a comment for this step in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this step icon 
changes to Vector 2.
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...........................................................................................................................................................................

13 Next, you need to disconnect weekend callers after playing an 
announcement. To test the weekend condition, select the Test palette 
again.

Result:  The available icons for the Test palette are displayed.

...........................................................................................................................................................................

14 Locate, select, and then drag and drop another Time Of Day icon onto 
the empty box for FALSE in the workspace area.

Result:  A second conditional branch is created, with two arrows 
pointing to empty step boxes.

...........................................................................................................................................................................

15 Select Properties  from the context (right-click) menu for the Time Of 
Day icon, or double-click the icon.

Result:  The Properties of Time Of Day window appears with default 
values.

...........................................................................................................................................................................

16 Select Friday from the drop-down list of values for the Start Day: field, 
enter 20: 00 in the Start Time: fields, then select Monday from the drop-
down list of values for the Finish Day: field, and enter 5: 00 in the Finish 
Time: fields.

Result:  Leading zeroes are discarded from numeric entries.

...........................................................................................................................................................................

17 Optionally, you may type a comment for this test in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this test icon 
changes to TOD Fri 20:00 to Mon 05:00.

...........................................................................................................................................................................

18 To specify the announcement to be played for weekend callers, select 
the Input/Output palette.

Result:  The available icons for the selected palette are displayed.

...........................................................................................................................................................................

19 Locate and select the Announcement icon, then drag and drop it on the 
empty step box for TRUE in the workspace area.

Result:  A yellow box appears when you can drop the icon.
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...........................................................................................................................................................................

20 Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result:  The Properties of Announcement window appears. The 
Extension: field is required.

...........................................................................................................................................................................

21 Select the Extension: field and enter 84573.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

...........................................................................................................................................................................

22 Optionally, you may type a comment for this icon in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this icon 
changes to Ext 84573.

...........................................................................................................................................................................

23 Now you want to disconnect the weekend calls. Select the End palette.

Result:  The available step icons change to display End icons.

...........................................................................................................................................................................

24 Locate and select the Disconnect icon, then drag and drop it on the 
empty box for TRUE in the workspace area.

Result:  A yellow box appears when you can drop the icon. The 
Disconnect step icon ends this conditional branch.

...........................................................................................................................................................................

25 Next, if the weekend condition tests false (the broken or dotted arrow), 
you want to queue the call. Select the Queue palette.

Result:  The available step icons change to display Queue icons.

...........................................................................................................................................................................

26 Locate and select the Queue Unconditional icon, then drag and drop it 
on the empty step box for FALSE in the workspace area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

27 Select Properties  from the context (right-click) menu for the Queue 
Unconditional icon, or double-click the icon.

Result:  The Properties of Queue Unconditional window appears.
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...........................................................................................................................................................................

28 Select Id from the drop-down list of values for the Skill: field.

Result:  The Skill Id: field is enabled and required.

...........................................................................................................................................................................

29 Select the Skill Id: field and enter 1.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

...........................................................................................................................................................................

30 Optionally, you may type a comment for this step in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this step icon 
changes to Skill 1.

...........................................................................................................................................................................

31 Now you want callers to wait while hearing ringback. Select the Input/
Output palette again.

Result:  The available step icons change to display icons for Input/
Output.

...........................................................................................................................................................................

32 Locate and select the Ringback icon, then drag and drop it on the empty 
step box in the workspace area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

33 Select Properties  from the context (right-click) menu for the Ringback 
icon, or double-click the icon.

Result:  The Properties of Ringback window appears with a default 
value of 0 seconds.

...........................................................................................................................................................................

34 Change the highlighted default value to 18 in the Seconds: field.

Result:  The Apply button is enabled in the Properties window.

...........................................................................................................................................................................

35 Optionally, you may type a comment for this step in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this step icon 
changes to 18 secs.
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...........................................................................................................................................................................

36 Next, you want to collect a digit after playing an announcement for the 
caller. Locate and select the Announcement icon, then drag and drop it 
on the empty step box in the workspace area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

37 Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result:  The Properties of Announcement window appears. The 
Extension: field is required.

...........................................................................................................................................................................

38 Select the Extension: field and enter 72349.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

...........................................................................................................................................................................

39 Optionally, you may type a comment for this icon in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this icon 
changes to Ext 72349.

...........................................................................................................................................................................

40 Locate and select the Collect icon, then drag and drop it on the empty 
step box in the workspace area.

Result:  The label shows the default is to collect 1 digit, so you do not 
need to edit this icon’s default properties.

...........................................................................................................................................................................

41 Now you want to route callers conditionally, based on the collected digit. 
You can add the condition later. Select the Routing palette.

Result:  The available icons change to display vector step icons for 
Routing.

...........................................................................................................................................................................

42 Locate and select the Route To Number icon, then drag and drop it on 
the empty step box in the workspace area.

Result:  A yellow box appears when you can drop the icon.
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...........................................................................................................................................................................

43 Select Properties  from the context (right-click) menu for the Route To 
Number icon, or double-click the icon.

Result:  The Properties of Route To Number window appears with 
default values.

...........................................................................................................................................................................

44 Change the highlighted default value in the Number: field to 
93031234567.

Result:  The Apply button is enabled in the Properties window.

...........................................................................................................................................................................

45 Optionally, you may type a comment for this icon in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this icon 
changes to 93031234567 no.

...........................................................................................................................................................................

46 You must add the conditional branch, so select the Test palette.

Result:  The available icons change to display Test icons.

...........................................................................................................................................................................

47 Locate and select the Caller Info icon, then drag and drop the icon onto 
the arrow BEFORE the Route To Number icon in the workspace area.

Result:  A yellow box appears when you can drop the icon between 
existing icons.

...........................................................................................................................................................................

48 Select Properties  from the context (right-click) menu for the Caller Info 
icon, or double-click the icon.

Result:  The Properties of Caller Info window appears with default 
values.

...........................................................................................................................................................................

49 Select digits from the drop-down list of values for the Measure: field.

Result:  The Apply button is enabled.

...........................................................................................................................................................................

50 Select the default value of 0 in the Threshold: field and change it to 5.

Result:  The highlighted value changes in the Properties window.
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...........................................................................................................................................................................

51 Optionally, you may type a comment for this icon in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this icon 
changes to DIG = 5.

...........................................................................................................................................................................

52 There are now two empty step boxes in the workspace area. The true 
box (solid arrow) is the next step if the collected digit was 5; otherwise, 
the false box is next. If their collected digit was not 5, you want callers 
to wait while hearing music, so select the Input/Output palette. 

Result:  The available icons change to display Input/Output icons.

...........................................................................................................................................................................

53 Locate and select the Music icon, then drag and drop it on the empty 
box for FALSE in the workspace area.

Result:  A yellow box appears when you can drop the icon.

...........................................................................................................................................................................

54 Select Properties  from the context (right-click) menu for the Music icon, 
or double-click the icon.

Result:  The Properties of Music window appears with a default value of 
0 seconds.

...........................................................................................................................................................................

55 Change the highlighted default value to 30 in the Seconds: field.

Result:  The Apply button is enabled in the Properties window.

...........................................................................................................................................................................

56 Optionally, you may type a comment for this step in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this step icon 
changes to 30 secs.

...........................................................................................................................................................................

57 You want to play an announcement for callers every 30 seconds. Locate 
and select the Announcement icon, then drag and drop it on the empty 
box after the Music icon.

Result:  A yellow box appears when you can drop the icon.
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...........................................................................................................................................................................

58 Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result:  The Properties of Announcement window appears. The 
Extension: field is required.

...........................................................................................................................................................................

59 Enter 74934 in the Extension: field.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

...........................................................................................................................................................................

60 Optionally, you may type a comment for this icon in the Comment: field, 
and then select OK.

Result:  The Properties window closes and the label for this icon 
changes to Ext 74934.

...........................................................................................................................................................................

61 Now to create a loop back to hearing music, drag the empty step box to 
the FALSE arrow immediately BEFORE the Music step icon.

Result:  A solid line joins this arrow, showing the unconditional nature of 
this goto step.

...........................................................................................................................................................................

62 Lastly, there is still an empty step box after the Route To Number icon. 
To finish editing your new vector, select the End palette.

Result:  The available step icons change to display End icons.

...........................................................................................................................................................................

63 Locate and select the Stop icon, then drag and drop it on the empty step 
box in the workspace area.

Result:  A yellow box appears when you can drop the icon. The Stop 
step icon ends this conditional branch.
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...........................................................................................................................................................................

64 If you haven’t already saved your work, select the Save item from the 
File menu or toolbar in the Vector Editor window.

Result:  The first time you save, a window will appear in which you 
specify where to save the vector. This can be off-line in a scratchpad, 
or on-line to a permitted ACD’s Vector Folder. If your vector is new on 
the ACD (you’re not saving using an existing vector’s name), you will 
be prompted for a Name and ID. If you saved an existing vector (or 
using its name), you will be prompted to overwrite it.

E N D  O F  S T E P S....................................................................................................................................................................................

Moving/Copying or
Saving Vectors to ACDs

of Differing Types

Important! You can move or copy vectors from one ACD to another 
using the Navigator tool. You can also open or create a vector of one 
type and save it to an ACD of a differing type, or copy and paste one 
or more steps between differing vectors using the Vector Editor tool. 
In these situations, vector steps need conversion. The software will 
guide you through the conversion.

...............................................................................................................................................................................

1 Open an existing or create a new Vector (EAS) containing skill-related 
properties of steps such as Queue Activity, Center Info, or Agent Activity 
and digit properties of steps such as Converse or Collect.

...........................................................................................................................................................................

2 Copy the whole vector or set of steps described in the preceding step.

...........................................................................................................................................................................

3 Open an existing or create a new Vector (non-EAS, non-Prompting)

...........................................................................................................................................................................

4 Paste the whole vector or set of steps you previously copied.

...........................................................................................................................................................................

5 You will be prompted with one or more windows explaining the 
necessary conversion(s). You may choose Yes to rectify incompatible 
steps individually, or Yes to All to rectify steps of the same type in all 
currently selected vectors/steps.

E N D  O F  S T E P S....................................................................................................................................................................................
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Printing Vectors

............................................................................................................................................................................................................................................................
Overview

Purpose This section describes how to print vectors and windows. Included are 
instructions for selecting a printer and specifying that printer’s properties. 
This print function is available only in the Vector Editor part of Visual 
Vectors.

In this section The section includes the following information:

• Printing a Vector

• Print Windows.
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............................................................................................................................................................................................................................................................
Printing a Vector

Selecting a printer ...............................................................................................................................................................................

1 Select the Print item from the File menu in the Vector Editor window. 

...........................................................................................................................................................................

2 Select the printer, print range, and number of copies

...........................................................................................................................................................................

3 Specify any printer properties, as needed. 

...........................................................................................................................................................................

4 Select OK.

Result:  The printing status window displays. The time required will 
vary, depending on which vector you are printing.

E N D  O F  S T E P S....................................................................................................................................................................................

Specifying printer
properties ...............................................................................................................................................................................

1 Select the Print item from the File menu in the Vector Editor window. 

...........................................................................................................................................................................

2 Complete the Print window by filling in the input field(s).

...........................................................................................................................................................................

3 Select the Properties button next to the Printer Name field.

...........................................................................................................................................................................

4 Specify or change any options in the Printer Properties window, as 
needed.

...........................................................................................................................................................................

5 Select OK.

Result:  The Print window displays again and the Printer fields are 
populated with any inputs you have previously entered.
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...........................................................................................................................................................................

6 Select OK.

Result:  The print operation runs.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Print Windows 

Overview The Print windows are provided by the Microsoft Corp. Windows operating 
system. See your windows documentation or on-line help for further 
information.

Print window item The following lists the Print window item and its definition.

Window 
Item

Function

Copies Specifies the number of copies to print.
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5 VDN Assignment Wizard

............................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use the VDN Assignment Wizard.

It is divided into the following sections:

• VDN Assignment Overview

• Using the VDN Assignment Wizard.

See the overview to each section for a preview of the section's contents.
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VDN Assignment Overview

............................................................................................................................................................................................................................................................
Overview

Purpose The VDN Assignment Wizard is accessed through CentreVu Framework. 
To access VDNs for one or more ACDs linked to CentreVu CMS server, 
you must connect to that server. You may connect by choosing Connect 
from the File menu or toolbar in the CentreVu Framework window.

In this section Topics include:

• Terms you need to know

• Starting the VDN Assignment Wizard

• Disconnecting and exiting the wizard.
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............................................................................................................................................................................................................................................................
Terms You Need to Know

Terms Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys   Keys that provide shortcuts to actions available on the 
menu.

Automatic Call  Distribution (ACD)   A switch feature using software that 
channels high-volume incoming and  outgoing call traffic to agent groups 
(splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Vectoring  A switch feature that provides a highly flexible method for 
processing ACD calls using VDNs and vectors as processing points 
between trunk groups and splits. Call vectoring permits treatment of calls 
that is independent of splits.

Similar to a computer program, a call vector is a set of instructions that 
control the routing of incoming calls based on conditions that occur in a 
call center environment. Examples of call vector conditions include time of 
day and the number of calls in queue.

CentreVu Visual Vectors window   The window in which you are 
currently working (usually indicated by a highlighted title bar). Visual 
Vectors has a Framework window and windows for each of the tools, 
including Navigator, Vector Editor, and VDN Assignment Wizard.

Container   An object in your Call Center World that logically contains 
other entities or objects. For example, each CMS object in your Call 
Center World can contain as many as 8 ACD objects, each of which 
contains entity folders (for announcements, split or skill objects, trunk 
groups, VDNs, and vectors).

Context menu   A menu with specific actions for an entity or object.

Entities   See object.

Folder   An object in the Navigator tool that contains entities 
(announcements, splits/skills, trunk groups, VDNs, and vectors). Folders 
are used to visually group all entities of a specific type for an ACD.

Input field   An area in a window into which you enter one or more valid 
values. Valid values may be integers, for example, or names assigned in 
the CentreVu CMS Dictionary.



  
VDN Assignment Wizard CentreVu Visual Vectors User Guide Release 8

Terms You Need to Know 5-4

Menu bar   A menu bar is under the title bar of most windows. The menu 
bar shows the menu names available for that particular window (for 
example, File and Help). You select an item from one of these drop-down 
menus.

Name (synonym) fields    Fields in which you may enter a name 
(synonym) that has been assigned in the CMS Dictionary (for example, the 
name of a vector).

Object   Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administrable entity itself (VDN).

Skill  An attribute that is assigned to an ACD Agent. Agent Skills can be 
thought of as the ability for an Agent with a particular set of skills to handle 
a call which requires one of those skills. In relationship to your call center, 
think of skill as a specific customer need/requirement or perhaps a 
business need of your call center. You will be defining your skills based on 
the needs of your customers and your call center.

Split  A group of extensions that receives special-purpose calls in an 
efficient, cost- effective manner. Normally, calls to a split arrive primarily 
over one or a few trunk groups.

Switch  A private switching system providing voice-only or voice and data 
communications services (including access to public and private networks) 
for a group of terminals within a customer’s premises.

Title bar   A title bar is across the top of most windows. The title bar shows 
the name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar   A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tools   The term tools refers to Navigator, Vector Editor and the VDN 
Assignment Wizard

Tools menu   A drop-down menu on the CentreVu Framework menu bar 
that gives you access to the Navigator, Vector Editor, and VDN 
Assignment Wizard tools.

Tooltips   Tooltips are available in most windows by placing the mouse 
cursor over an item for two seconds. Tooltips usually describe the actions 
performed by selecting an icon. Tooltips can be disabled on the 
Preferences window accessed from the File menu of CentreVu 
Framework.

VDN  See Vector Directory Number.
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VDN Assignment Wizard   The window that displays after you select it 
from the Tools menu or toolbar in the CentreVu Framework window. It 
consists of several dialog boxes in sequence; for example, one filters and 
selects the VDNs you wish to assign, and another performs the 
assignment(s).

VDN Skill Preferences  Up to three skill(s) can be assigned to a VDN. 
Calls use VDN skills for routing based on your preference (as you 
administer it in the vector). VDN skill preferences are referred to in the 
vector as “1st,” “2nd,” or “3rd.”

A prioritized list of agent skills administered for a VDN that are required or 
preferred for the answering agent. VDN Skill Preferences represent the 
requirement that a call be routed to an ACD agent with a particular ability 
or set of abilities.

Vector  A list of steps that process calls in a user-defined manner. The 
steps in a vector can send calls to splits, play announcements and music, 
disconnect calls, give calls a busy signal, or route calls to other 
destinations. Calls enter vector processing via VDNs, which may have 
received calls from assigned trunk groups, from other vectors, or from 
extensions connected to the switch.

Vector Command    A vector step that describes the action to be 
executed for a call (for  example, Queue, check, disconnect).

Vector Directory Number (VDN)  An extension number that enables calls 
to connect to a vector for processing. A VDN is not assigned an equipment 
location. It is assigned to a vector. A VDN can connect calls to a vector 
when the calls arrive over an assigned automatic-in trunk group or when 
calls arrive over a dial-repeating (DID) trunk group and the final digits 
match the VDN. The VDN by itself may be dialed to access the vector from 
any extension connected to the switch.

Vector Editor   This software tool, accessed from CentreVu Framework, 
allows you to create and edit vectors visually, by dragging and dropping 
icons representing switch commands from a palette and arranging them 
into vector steps in a work area. You can attach comments, change layout, 
and save and print the vectors.

Vector Step  One processing step in a vector. A vector step consists of a 
command and one or more conditions.

Vector Step Condition  A condition accompanying a vector command 
that defines the circumstances in which the command will be applied to a 
call. To visually edit the condition, access the properties for the vector 
step.
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............................................................................................................................................................................................................................................................
Starting the VDN Assignment Wizard

Procedure Use the steps below to start VDN Assignment Wizard for Microsoft Corp. 
Windows 95/98 or Microsoft Corp. Windows NT 4.0.

...........................................................................................................................................................................

1 Select the Lucent CentreVu Visual Vectors program group from the 
Programs sub-menu of the Start menu.

...........................................................................................................................................................................

2 Select the CentreVu Visual Vectors 8.0 item from the program group.

...........................................................................................................................................................................

3 Select VDN Assignment Wizard from Framework’s Toolsmenu or 
toolbar.

Result:  The Visual Vectors software application opens. The CentreVu 
Framework window displays. Although the software is now running, 
you are not yet connected to a CMS server.

Result:  CentreVu Framework is Visual Vectors’ main window. You will 
use the toolbar buttons and pull-down menus to access tools, including 
Navigator, that contain information about ACD entities from the CMS 
server.

Result:  The following figure illustrates how the window appears before 
logging into the CMS server.

E N D  O F  S T E P S....................................................................................................................................................................................
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............................................................................................................................................................................................................................................................
Disconnecting and exiting the wizard

Procedure To exit any window in the wizard, select the Cancel  button, or press Esc  
on your keyboard.

To exit the software, select Exit from the File menu in the CentreVu 
Framework main window. The software automatically disconnects from 
any CMS servers to which you are connected and then closes CentreVu 
Framework window. A warning message appears if you have open tool 
windows.

If you try to close or exit CentreVu Framework and you have open tool 
windows, a warning message will be displayed. If you restart CentreVu 
Framework, it will attempt to restore the windows left open during the last 
session and it will attempt to restore the CMS server connections used 
during the last session. See Disconnecting and exiting the software (4-13).
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Using the VDN Assignment Wizard

............................................................................................................................................................................................................................................................
Overview

Purpose This section introduces you to VDN Assignment window features as they 
appear both before and after connecting to CentreVu CMS. Follow the 
instructions to — among other tasks — make VDN selections, use 
windows, and enter values in input fields.

In this section This section includes the following information:

• Basic VDN Assignment Wizard features

• Using VDN Assignment windows.
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............................................................................................................................................................................................................................................................
Basic VDN Assignment Wizard Features

Overview This section describes the VDN Assignment  Wizard as it appears before 
you connect to a CMS server.

VDN Assignment Wizard
window

The following figure shows the VDN Assignment Wizard window:

System menu box A common convention. The system menu box enables you to perform 
Microsoft Corp. Windows operations, such as closing the current window 
or application. 

Title bar A common convention. The title bar shows the name of the application.
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Minimize, maximize/
restore and close

buttons

A common convention. The buttons in the upper right-hand corner adjust 
the size of the current window, or close it. 

Buttons The windows contain buttons to help you complete your tasks.

These four buttons appear on the windows of the VDN Assignment 
Wizard:

Button Function

Cancel Closes the wizard without making or changing any 
assignments.

Back Displays the previous window in the wizard. Disabled on the 
first window.

Next Next accesses the next window in the wizard. This button is 
replaced by the Edit in the last window. See Edit.

Edit Edit accesses the properties window for one or more selected 
VDNs.

Help Accesses a help window about the current window. 
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............................................................................................................................................................................................................................................................
Using VDN Assignment Windows

Overview The following describes how to use the three windows that comprise the 
VDN Assignment Wizard.

Welcome window To use the first window of the VDN Assignment Wizard, do the following:

...............................................................................................................................................................................

1 Browse your Call Center World and find the ACD containing the VDNs 
you want. For example, double-click a CMS server to explore the ACDs 
it contains.

• Click the + icon next to a CMS to show its ACDs. If you are not 
connected to a server, first double-click it and complete the Connect 
to server window. Then you can show its ACDs.

• If needed to reduce clutter, click the – icon to the left of a container to 
hide the objects within it. Hiding ACDs does not disconnect you from 
their CMS.

Result:  The Welcome to the VDN Assignment Wizard window appears.
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...........................................................................................................................................................................

2 Select (for example, by clicking to highlight it) the ACD for which you 
wish to do VDN Assignment(s), as shown in the following figure.

...........................................................................................................................................................................

3 Select the Next button to go to the next window in the wizard.

Result:  The Selection window appears.

E N D  O F  S T E P S....................................................................................................................................................................................
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VDN Selection window To use the next window to select VDNs for which to make assignments, do 
the following:

...........................................................................................................................................................................

1 Leave the Filter: text box blank if you want to display a list of all VDNs 
Available for Selection on the Selected ACD.

Optionally, you may filter the list of VDNs Available for Selection by 
entering any of the following in the Filter: text box.

• 1 to 20 characters. Letters, numbers, underscores ( _), blanks, 
commas ( ,), periods ( .), and plus signs ( +) are valid. 

Characters that are not allowed include backslash ( \), grave accent ( 
`), tilde ( ~ ), double quotes ( "), pipe symbol ( |).

• pattern-matching wildcards, such as

– ? (exactly one character)

– * (any number of characters, including none).

Entering characters or characters with wildcards restricts the VDNs 
displayed in the Available for Selection (Filtered): list box to those that 
partially or completely match your entry. For example, entering *Sales* 
would match and display available VDNs named Pre-Sales, Sales, and 
Sales Split. Entering VDN*1 would match and display available VDNs 
named VDN1, VDN 201, and VDNSupport01.
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The following figure shows the filtered list of VDNs Available for Selection:

...........................................................................................................................................................................

2 Select one or more VDNs you want to administer from the filtered list of 
VDNs Available for Selection, using any of the following methods: 

• Highlight the VDN in the Available for Selection: list box (for example, 
single-click it) select the down arrowhead ↓ button.

• Hold down the Ctrl key while you highlight each one of the VDNs that 
you want and then select the down arrowhead ↓ button.

• Hold down the Shift key while you highlight the first and last in a 
group of VDNs that you want and then select the down arrowhead ↓ 
button.

• Select the down arrowhead button with the horizontal line under it to 
move all VDNs in the filtered Available for Selection: list box to the 
Selected: list box.
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You may deselect one or more VDN(s) by reversing any of these actions, 
for example using the up arrowhead button ↑ to move highlighted VDNs in 
the Selected: list box back to the Available for Selection: list box.

Result:  The following figure shows the Selected list of VDNs below the 
filtered list of VDNs Available for Selection.

...........................................................................................................................................................................

3 Select the Next button to go to the next window in the wizard.

Result:  The Edit Assignment window appears.

E N D  O F  S T E P S....................................................................................................................................................................................
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Edit Assignment window To use the last window of the VDN Assignment Wizard, do the following:

...........................................................................................................................................................................

1 Confirm that the Selected ACD and Selected VDNs are correct.

Result:  The following figure shows the Selected ACD and Selected 
VDNs:
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...........................................................................................................................................................................

2 Select the Edit button to assign the Selected VDN(s) to a vector or 
change other VDN object properties.

Result:  If you selected one VDN, the property window for that VDN will 
show editable values in its property fields. If you selected many VDNs 
with the same values, the property window will show the common 
values in the property fields. If you selected many VDNs with different 
values, the property window will show blank property fields for you to 
complete.
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...........................................................................................................................................................................

3 Select a Vector Id from the drop-down list of available vectors. If the 
Selected VDN(s) already are assigned to a common vector, it is the 
default selection. 

If the selected VDN is not already assigned to a vector, then [none] is the 
default. You cannot assign [none] to a vector.

Result:  The following figure shows the Vector Id drop-down list:
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...........................................................................................................................................................................

4 Select one or more skill preferences from the drop-down lists of 
available skills (if the EAS feature has been purchased and enabled on 
the selected ACD). If the Selected VDN(s) already are assigned  a 
common skill, they are the default selections. If you choose [none] for 
Skill Preference 1, then Skill Preference 2 and Skill Preference 3 also 
must be [none]. If you choose [none] for Skill Preference 2, then 
Skill Preference 3 also must be [none].  Note that choosing [none] 
will remove existing skill preferences from those selected VDNs that 
have them.

Result:  The following figure shows the Skill Preferences drop-down list:
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...........................................................................................................................................................................

5 Select the OK button to commit all the VDN Assignment(s) and any 
other changes to VDN properties and close the window. You may also 
select the Apply button to commit changes but leave the VDN 
Properties window open for further input.

E N D  O F  S T E P S....................................................................................................................................................................................
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Glossary

Accelerator Keys 
Keys that provide shortcuts to actions available on the menu.

Access Permissions
Permissions assigned to a user so that the user can access different areas of a server or 
administer specific entities (for example, splits/skills, trunk groups, vectors, and VDNs) of an ACD. 
Access permissions are specified as read or write permission. Read permission means the user 
can access and view data. Write permission means the user can add, modify, or delete data and 
execute processes.

ACD 
See Automatic Call Distribution.

Active VDN Calls 
Also known as counted-calls to VDN. A Call Vectoring capability available with G3V4 or later 
switches. Counted-calls to VDN is a parameter of the go to step and go to vector 
commands that provides conditional branching (to a different step in the same vector or to a 
different vector) based on the number of incoming trunk calls a VDN is currently processing in a 
vector or at an agent.

Agent 
A person or VRU port that answers calls to an ACD split/skill. The agent  is known to CMS by a 
login identification keyed into a voice terminal.

Agent Login ID
A 1- to 4-digit number (Generic 2) or a 1- to 9-digit number (Generic 3) entered by an ACD agent 
from a voice terminal to activate the agent position. Agent logins are required for all CMS-
measured ACD agents.
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Agent Skill 
An attribute that is associated with an ACD agent. Agent Skills can be thought of as the ability for 
an agent with a particular set of skills to  handle a call that requires one of a set of skills. An agent 
can be assigned  up to 20 skills. The meaning of each Agent Skill is defined by the customer. 
Examples of what could be considered skills are: the ability to speak a particular language or the 
expertise to handle a certain product.

See Primary Skill, Secondary Skill, and Skill Level.

Announcement 
A recorded voice message that normally tells the caller what destination  the call has reached. The 
announcement also often tries to persuade the  caller to stay on the line. With Call Vectoring, 
announcements can be part  of a vector’s call processing. An announcement is assigned to a 
vector by  entering an announcement number.

Automatic Call  Distribution (ACD)
A switch feature using software that channels high-volume incoming and  outgoing call traffic to 
agent groups (splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Center World 
A collection of objects and entities that can be viewed and administered through CentreVu 
Framework. What you can access, edit or assign depends on your permissions.

Call Management System  (CMS)
A software product used by business customers that have Lucent  Technologies 
telecommunications switches/ECS and receive a large  volume of telephone calls that are 
processed through the Automatic Call  Distribution (ACD) feature of the switch/ECS. The CMS 
collects call-traffic  data, formats management reports, and provides an administrative  interface 
to the ACD feature in the switch/ECS.

Call Prompting 
A switch feature that routes incoming calls based on information entered  by the calling party, such 
as an account number. The caller receives an  announcement and is prompted to select an option 
from those listed in  the announcement.
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Call Vectoring
A switch feature that provides a highly flexible method for processing ACD calls using VDNs and 
vectors as processing points between trunk groups and splits. Call vectoring permits treatment of 
calls that is independent of splits.

Similar to a computer program, a call vector is a set of instructions that control the routing of 
incoming calls based on conditions that occur in a call center environment. Examples of call vector 
conditions include time of day and the number of calls in queue.

CentreVu Advocate

A set of features designed to enhance call and agent selection within a call center. CentreVu 
Advocate requires CentreVu Supervisor Version 6 or later, DEFINITY ECS R6 or later, and 
Expert Agent Selection. See CentreVu Advocate User Guide, 585-215-855 for more information.

CentreVu CMS
See Call Management System.

CentreVu Framework 
The Visual Vectors software window from which you access tools such as Navigator, Vector Editor, 
and VDN Assignment. You can also use Framework File menu items to Connect to or Disconnect 
from CentreVu CMS servers.

CentreVu Supervisor
The Call Management System client application for the Microsoft Corp. Windows operating 
environment.

CentreVu Visual Vectors window 
The window in which you are currently working (usually indicated by a highlighted title bar). Visual 
Vectors has a Framework window and windows for each of the tools, including Navigator, Vector 
Editor, and VDN Assignment.

Container 
An object in your Call Center World that logically contains other entities or objects. For example, 
each CMS object in your Call Center World can contain as many as 8 ACD objects, each of which 
contains entity folders (for announcements, split or skill objects, trunk groups, VDNs, and vectors).

Context menu 
A menu with specific actions for an entity or item.

Current window 
The window in which you are currently working (usually indicated by a highlighted title bar).
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Data Collection Off
CMS is not collecting ACD data. If you turn off data collection, CMS will not void data on current 
call activity.

Data Collection On 
CMS is collecting ACD data.

Database 
A group of files that store ACD data according to a specific time frame:  current and previous 
intrahour real-time data and intrahour, daily, weekly,  and monthly historical data.

Database Item 
A name for a specific type of data stored in one of the CMS databases. A  database item may store 
ACD identifiers (split numbers or names, login  IDs, VDNs, etc.) or statistical data on ACD 
performance (number of ACD  calls, wait time for calls in queue, current states of individual 
agents, etc.).

Database Tables 
CMS uses these tables to collect, store, and retrieve ACD data. Standard  CMS items (database 
items) are names of columns in the CMS database  tables.

Date Format
The standard format for entering dates on Supervisor reports. 

Acceptable formats are:

• Month/day/year (for example, 3/21/93).

• A “-” offset based on today's date (for example, -1 for yesterday). You can also enter 
a range of numbers (for example, 0 through -7).

• Separating individual data entry items using a semicolon (for example, 3/21/93;3/23/
93;3/25/93)

• Entering ranges by placing a hyphen between entries (for example, 3/21/93-3/25/
93).

When you specify a date for a weekly report, that date or range of dates must correspond to the 
week start day selected in the System Setup-Storage Intervals window. If the date and day do not 
match, the message No records found displays in the status line.

The month start date must be the first day of the month.

Delete 
An action that removes the entry on the window from the database.
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Dictionary
A CMS subsystem that can be used to assign names to various call center elements such as login 
IDs, splits/skills, trunk groups, VDNs and vectors. These names appear on reports, making them 
easier to interpret.

EAS 
See Expert Agent Selection.

Entity 
A generic term that refers to one of the following: Announcement, Split/Skill, Trunk Group, VDN, 
or Vector. Entities that CentreVu Visual Vectors can view or administer include Vectors and VDNs. 
Entity names are obtained from the CentreVu CMS Dictionary; renaming entities using Visual 
Vectors results in changes to the CMS Dictionary.

Error Message 
A response from a program indicating that a problem has arisen or  something unexpected has 
happened, requiring your attention.

Expert Agent Selection (EAS)
Expert Agent Selection (EAS) is an optional switch feature that builds on the power of the Call 
Vectoring and ACD features of the switch to match the skills required to handle a particular call to 
an agent who has at least one of the skills that a caller requires. The ACD queuing and the Queue 
and Check  vector commands are used to route a call to an agent with the appropriate skill to 
handle that call. With EAS, call distribution is based on skill.

CentreVu CMS collects data on skills in the same manner as it collects data on splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that customers can assess the 
call center performance relative to calls requiring particular skills. CMS reports how many calls 
were handled, how long these calls waited for service, and the average talk time for calls queued 
to a particular skill preference in a particular VDN.

Folder 
An object in the Navigator tool that contains entities (splits/skills, trunk groups, VDNs, and 
vectors). Folders are used to visually group all entities of a specific type for an ACD.

Historical Database
Contains intrahour records for up to 62 days, daily records for up to 5 years, and weekly/monthly 
records for up to 10 years for each CMS-measured agent, split/skill, trunk, trunk group, vector, and 
VDN.

INFORMIX
A relational database management system used to organize CMS historical data.
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INFORMIX SQL
The interactive interface typically used to view the INFORMIX database.

Integrated Services Digital Network (ISDN)
A digital standard for telephony that enables, among other things, telephone, television, and 
computer signals on the same lines. This system may someday replace our existing telephone 
lines.

ISDN 
See Integrated Services Digital Network.

LAN 
See Local Area Network.

Local Area Network
A private interactive communication network that allows computers to  communicate over short 
distances, usually less than one mile, at high  data transfer rates from 1 Mbps to as high as 100 
Mbps.

Logical Agent
An EAS feature that associates the agent’s login ID with the physical extension when the agent 
logs in. Properties such as the assigned skills, class of restriction, and coverage path are 
associated with the login ID rather than the physical extension. This allows agents to log in at any 
available set.

Agents are assigned a single set of work mode buttons, rather than one set per skill. This simplifies 
the agent's interface to the work mode buttons. When the “MI” or “AI” button is lit, the agent is 
available to take a call in any assigned skills.

The Logical Agent capability allows calling agents to connect by dialing into their login IDs. Calls 
to login IDs may be treated as direct agent ACD calls, given the proper class of restriction, or may 
be treated as extension (personal) calls. Treating the calls as direct agent calls can be used to 
help distinguish business-related from personal calls.

Look Ahead Interflow  (LAI) 
A switch feature that can be used to balance the call load among multiple call centers. The LAI 
feature works with Call Vectoring and ISDN PRI trunks to intelligently route calls between call 
centers. This allows multiple call centers to share work loads, expands hours of coverage, and 
allows calls to be transparently handled by call centers in different time zones.

Measured
A term that means an ACD entity (agent, split/skill, trunk, trunk group, vector, VDN) has been 
identified to CMS for collection of data. If the ACD element is not measured, no data is collected.
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Menu bar 
A menu bar is under the title bar of most windows. The menu bar shows the menu names available 
for that particular window (for example, File and Help). You select an item from one of these drop-
down menus.

Message Windows
Temporary windows used only for displaying information like syntactical field errors.

Multiuser Mode
Any administered CMS user can log into CMS. Data continues to be collected if data collection is 
“on.”

Name (Synonym) Fields
Fields in which you may enter a name (synonym) that has been entered in the CMS Dictionary (for 
example, names of splits/skills, trunk groups, vectors, VDNs).

Navigator 
A window that displays after you select it from the Tools menu or toolbar in the CentreVu 
Framework window. It consists of two panes: a hierarchical “tree” view of your Call Center World 
on the left and a list of objects or entities on the right.

Nonprimary Split/Skill
When a call is queued to multiple splits/skills, the second and third splits/skills to which the call 
queues in a VDN are called nonprimary splits/skills. They are also referred to as secondary and 
tertiary splits/skills, respectively.

Object 
Any item which may appear in your Call Center World through the Navigator tool. Objects can be 
containers of other objects or entities (VDNs folder), or an object may be an administrable entity 
itself (VDN).

Primary Skill
Skills assigned to an agent. Primary skills are the areas in which the agent has the most expertise.

See also Agent Skill.

Pseudo-ACD 
An area you create on your CMS to place previously backed-up ACD  data. A pseudo-ACD is not 
a live (real) ACD and does not communicate  with any switch.
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Queue
A holding area for calls waiting to be answered in the order in which they were received. Calls in 
a queue may have different priority levels, in which case, calls with a higher priority are answered 
first.

QUEUED
A trunk state. An ACD call has seized the trunk and is queued to a split/skill waiting for an agent 
to answer.

Read Permission
The CMS user can access and view data (for example, run reports or view the Dictionary 
subsystem). Read permission is granted from the User Permissions subsystem.

Real-Time Database
Consists of the current and previous intrahour data on each CMS-measured agent, split, trunk, 
trunk group, vector, and Vector Directory Number (VDN).

ScratchPad
The Default ScratchPad name is a container area on your PC designed to save vectors off-line 
when a switch/ECS link or CMS connection is not available. You can create a hierarchy of sub-
folders under the default folder by selecting New ScratchPad from Navigator’s Filemenu.

Secondary Skill 
Skills assigned to an agent. Secondary skills are the areas in which the  agent does not have 
extensive expertise, or is not the agent’s preference.  (Used in G3V2 through G3V4 with EAS.)

See Agent Skill, Skill Level.

SEIZED
A trunk state. A call is using the trunk either incoming or outgoing.

Service Observing-VDNs
A feature available with G3V4 or later switches that gives a voice terminal user the ability to 
monitor the treatment a call receives as it is processed by a VDN.

Single-User Mode
Only one person can log into CMS. Data continues to be collected if data collection is “on.” This 
mode is required to change some CMS administration.



  
Glossary CentreVu Visual Vectors User Guide Release 8

GL-9

Skill
An attribute that is assigned to an ACD Agent. Agent Skills can be thought of as the ability for an 
Agent with a particular set of skills to handle a call which requires one of those skills. In relationship 
to your call center, think of skill as a specific customer need/requirement or perhaps a business 
need of your call center. You will be defining your skills based on the needs of your customers and 
your call center.

Skill Hunt Group 
When EAS is enabled, calls route to specific skill hunt groups. These skill  hunt groups are usually 
based on the needs of your customers. Agents  are not assigned to a skill group (like split hunt 
groups), but agents are assigned specific skills that become active when they log in to their voice 
terminal.

Skill Level 
A priority level from 1 (highest) to 16 (lowest) indicating an agent’s level of  expertise or ability to 
handle calls to the given skill. (ECS Version 5 and later.)

Split
A group of extensions that receives special-purpose calls in an efficient, cost- effective manner. 
Normally, calls to a split arrive primarily over one or a few trunk groups.

Staffed Agent
An agent who is currently logged in to the switch.

Station
An unmeasured extension. An extension that is not currently staffed by an agent or that is a 
member of an unmeasured split/skill or hunt group.

Status bar 
A status bar is across the bottom of some windows. The status bar shows information about the 
current action in that window.

Switch
A private switching system providing voice-only or voice and data communications services 
(including access to public and private networks) for a group of terminals within a customer’s 
premises.

Tertiary Split/Skill
Generic 3 with vectoring, Generic 2.2 with EAS only. When a call is queued to multiple splits/skills, 
the third split/skill the call queued to in a VDN is called the tertiary split/skill.
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Time Format
The standard format for entering times on CMS reports. 

Acceptable formats are:

• AM/PM format (for example, 7:30AM-5:00PM).

• Military time format (for example, 7:30-17:00).

Title bar 
A title bar is across the top of most windows. The title bar shows the name of that particular window 
(for example, Navigator). Titles of open tool windows will be listed on the Window menu of 
CentreVu Framework.

Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons represent actions you can 
perform.

Tooltips 
Tooltips are available in most windows by placing the mouse cursor over an item for two seconds. 
Tooltips usually describe the actions performed by selecting an icon.

Trunk
A telephone circuit that carries calls between two switches, between a Central Office (CO) and a 
switch, or between a CO and a phone.

Trunk Group
A group of trunks that are assigned the same dialing digits - either a phone number or a Direct 
Inward Dialed (DID) prefix.

Universal Call Identifier (UCID)
A number that uniquely identifies a call in a network of nodes that support UCID. This number will 
be a part of the records in the Call History feature of CMS.

User ID
The login ID for a CMS user.

User Permissions
An area of the CMS server that allows the CMS administrator to define what each user has access 
to.

VDN
See Vector Directory Number.
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VDN Assignment 
The VDN Assignment Wizard, accessed from CentreVu Framework, guides you through the 
process of assigning a vector and skill preference to a VDN. The windows that display after you 
select Vector Id or Skill Pref from the context menu of a VDN object are part of this tool.

VDN Calls-Counted
Also known as counted-calls to VDN and active VDN calls. A Call Vectoring capability available 
with G3V4 or later switches. Counted-calls to VDN is a parameter of the go to step and go to 
vector commands that provides conditional branching (to a different step in the same vector or 
to a different vector) based on the number of incoming trunk calls a VDN is currently processing.

VDN of Origin  Announcement (VOA)  
A short announcement that is assigned to a VDN through switch  administration. The VOA 
identifies the origin or purpose of a call for the  call center agent who answers the call.

VDN Skill Preference
Up to three skill(s) can be assigned to a VDN. Calls use VDN skills for routing based on your 
preference (as you administer it in the vector). VDN skill preferences are referred to in the vector 
as “1st,” “2nd,” or “3rd.”

A prioritized list of agent skills administered for a VDN that are required or preferred for the 
answering agent. VDN Skill Preferences represent the requirement that a call be routed to an ACD 
agent with a particular ability or set of abilities.

Vector
A list of steps that process calls in a user-defined manner. The steps in a vector can send calls to 
splits, play announcements and music, disconnect calls, give calls a busy signal, or route calls to 
other destinations. Calls enter vector processing via VDNs, which may have received calls from 
assigned trunk groups, from other vectors, or from extensions connected to the switch.

Vector Command  
A vector step that describes the action to be executed for a call (for  example, Queue, check, 
disconnect).

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for processing. A VDN is not 
assigned an equipment location. It is assigned to a vector. A VDN can connect calls to a vector 
when the calls arrive over an assigned automatic-in trunk group or when calls arrive over a dial-
repeating (DID) trunk group and the final digits match the VDN. The VDN by itself may be dialed 
to access the vector from any extension connected to the switch.
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Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to create and edit vectors 
visually, by dragging and dropping icons representing commands from a palette and arranging 
them into vector steps in a work area. You can attach comments, change layout, and save and 
print the vectors.

Vector Step
One processing step in a vector. A vector step consists of a command and one or more conditions 
or parameters. These conditions or parameters are found on a step’s Properties window in Visual 
Vectors client software.

Vector Step Condition
A condition accompanying a vector command that defines the circumstances in which the 
command will be applied to a call. These conditions are found on a step’s properties window in 
Visual Vectors client software.

VOA  
See VDN of Origin Announcement.

Visual Vectors Client 
Client software which provides a rich, graphical user interface for creating or modifying configured 
elements of ACDs connected to a CMS.

Visual Vectors Server 
Server software which enables administration (changing or modifying configured elements) for 
ACDs connected to a CMS.

Voice Terminal
A telephone set, usually with buttons, that gives an agent some control over the way calls are 
handled.

Write Permission
The CMS user can add, modify, or delete data and execute processes. Write permission is granted 
from the User Permissions subsystem.
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